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About DMTI Spatial™

DMTI Spatial Inc. is Canada’s leading spatial solutions provider. We enable users to understand their
customers, optimize resources, realize opportunities, maximize profitability and make more informed
decisions through accurate products and innovative thinking.

DMTI Spatial publishes precision built street map, rail and routing data (CanMap ), a detailed water layer,
and innovative geocoding and address management software (GeoPmpomt ) In addition, DMTI Spatial
publishes a full range of positionally accurate geospatial data products including: enhanced points of
interest (EPQOI), census data and boundaries, postal geography, topographic maps, and US mapping
data. As part of a complete business geographic solution, DMTI Spatial offers a wide range of GIS
services, consulting, and software training.

Established in 1994, DMTI Spatial is committed to setting the standard within the GIS industry for
precision built spatial data and geocoding software products.

At DMTI Spatial, we believe that our true strength comes from working closely with our customers and
providing innovative solutions to meet their strategic business objectives. As Canada’s premier spatial
solutions provider we pride ourselves with having worked with North America’s leading organizations to
support their mission critical applications.

DMTI Spatial works with large and small organizations representative of a wide variety of industries:

e Agriculture » Forestry e  Mining

e Banking/Finance e Government * Real Estate

e Consulting e Health * Retail

» Education * High Technology e Telecommunications
 Emergency Services e Insurance e Transportation

» Engineering e Manufacturing «  Utilities

*  Environmental * Media

We are a member of the ESRI Canada Business Partner Program, and winner of the 2001 ESRI
Worldwide New Business Partner of the Year Award. Strategic business partner of Tele Atlas North
America, and winner of the Markham Board of Trade 2000 Award for Entrepreneurship and Innovation.
Recipient of The Association of Canadian Map Libraries and Archives (ACMLA) 2002 Certificate of
Appreciation.

Tele Atlas

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
Not to be disclosed



[0 2004 DMTI Spatial Inc.

Really Smart Spatial Solutions™
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Through the application of its products and services, DMTI Spatial has been involved with projects such
as: location-based services, logistics planning, emergency dispatch, facilities management, data
management, customer care, address management, land base development in support of network
planning, and marketing/demographic analysis applications.

DMTI Spatial can provide all of the components necessary for the acquisition, implementation, operation
and maintenance of a successful GIS system within companies of all sizes. Through its product and
service offering, DMTI Spatial can provide users with 5 key components:

1. Accurate, detailed and compatible data
2. Comprehensive maintenance program
3. GIS software

DMTI Spatial™ Product & Service Portfolio

DMTI Spatial's product & service offering
includes:

CanMap® - Digital Map Data for Canada
. CanMap® Streetfiles

« CanMap® RouteLogistics

« CanMap® Rail

. CanMap® Major Roads and Highways
. CanMap® Parks

« CanMap® Water

MultiNet™ - Digital Map Data for USA
* Tele Atlas MultiNet™

Municipal Amalgamations
e Municipality Amalgamation File (MAF)

Business & Recreational Points of Interest
e Enhanced Points Of Interest (EPOI)

GeoPinpointm Suite

» Canada’s Geocoding Solution

* Modular Architecture

e Windows Standalone Desktop Version

e UNIX, Java Wrapper, ActiveX (DLL Version)

Topographic Data and Base Maps

e Canadian Atlas Map Bundle (CAMB)

» Populated Placenames

« National Topographic Data Base (NTDB)
* 30 & 90m Digital Elevation Models (DEM)
e Clutter Data

Postal Geography & Data

« Six-Digit Postal Code File

» Enhanced Postal Code File

» Forward Sortation Area (FSA) Boundary File

www.dmtispatial.com

4. Consulting and services
5. Software training

1996 Census Boundaries & Demographic Data

* Enumeration Area (EA)

e Census Subdivision (CSD)

e Census Division (CD)

» Census Metropolitan Area/Census
Agglomeration (CMA/CA)

e Census Tract (CT)

e Federal Electoral Districts (FED)

2001 Census Boundaries

» Dissemination Area (DA)

e Census Subdivision (CSD)

e Census Division (CD)

» Census Metropolitan Area/Census
Agglomeration (CMA/CA)

» Census Tract (CT)

e Federal Electoral Districts (FED)

GIS Software

» Contour Modeling and Display

» Demographic Profiling and Lifestyle Targeting
» Geocoding and Mapping Software

* Routing and Logistics

Consulting and Services

» Address Management Solution (AMS)
e Application Development

» Database Marketing

» Data Conversion and Creation

e Database Scrubbing

e Geocoding Services

* GIS Consulting

» Technical Support

Proprietary and Confidential to DMTI Spatial
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Error Reporting & Wish List Services

DMTI Spatial is committed to building the best products possible for our customers. By using our data
every day in your mission critical application you are our best product tester. Please let us know if you
have found an error in any of our products so that we can make the correction for the next release.

This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.
Please be as specific as possible so that we can improve our products quickly and accurately. To access
the Error Reporting Web page please visit: http://www.dmtispatial.com/error _reporting.html or send
an e-mail to: fixme@dmtispatial.com

If you have an idea for a new product or an existing product enhancement, please submit your ideas to
the Wish List Web page: http://www.dmtispatial.com/product wish list.html or send an e-mail to:
wishlist@dmtispatial.com

Over the coming months DMTI Spatial will keep you informed of new product releases, enhancements
and strategic alliances. Our goal is to provide you with powerful knowledge based tools to help you attain
and maintain your competitive advantage.

Contact Information
DMTI Spatial Inc.

625 Cochrane Drive, 3" Floor
Markham, Ontario

L3R 9R9 Canada

Telephone: 905-948-2000

Toll Free: 1-877-477-DMTI (3684)
Fax: 905-948-9404

URL: www.dmtispatial.com
Email: info@dmtispatial.com

© 2004 DMTI Spatial Inc. CanMap is a registered trademark of DMTI Spatial Inc. DMTI Spatial, Really
Smart Spatial Solutions, Because Where Is What Matters and GeoPinpoint are trademarks of DMTI
Spatial Inc. All rights reserved. Other products and company names mentioned herein may be
trademarks of their respective companies. Mention of third-party products is for informational purposes
only and constitutes neither a recommendation nor an endorsement.

DMTI Spatial is an Authorized User and Distributor of selected Statistics Canada Computer File(s) under
Licensing Agreement 6228. No confidential information about an individual, family, household,
organization or business has been obtained from Statistics Canada.

© Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of
Industry, Statistics Canada 2004.

Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with
permission of Natural Resources Canada and The Queen in Right of Manitoba.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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About EPOI

File Properties

Property Description

Coverage Nationwide

Currency February 15, 2004

Projection Unprojected Longitude-Latitude
Datum NADS83

Format ASCI| text files (comma delimited)”

File Naming Conventions

Representing the data coverage, files are either named by a region, Statistics Canada census subdivision
(CSD) number, or a Standard Industrial Classification.

File Names by Region

For example:  \On.txt

v

Geographic Area Abbreviation®
ON

File Names by 1996 Census Subdivision (CSD)

Census Subdivision is the general term applied to municipalities (as determined by provincial legislation)
or their equivalent, for example Indian reserves, Indian settlements and unorganized territories.

All files are prefixed with the Census Subdivision Code. An additional text file (CSD.txt) containing a CSD
and its associated municipality name is included in each order by CSD.

For example: \3520004_ A.txt

PN

Census Subdivision File Name
3520004 (Toronto) A (Division A)

File Names by Standard Industrial Classification (SIC)
Orders by SIC will contain the SIC specification of the data purchased in the file name.®

For example: \OnA.txt

/\

Geographic Area Abbreviation File Name
ON A (SIC Division A)

! See Appendix A: Importing Data Into GIS Software for information on how to import EPOI files into GIS software (including
Maplnfo, ArcView 3.x, and ArcGIS 8.1).

2 See Appendix B: Provincial and Territorial Abbreviations and Codes and Appendix C: Canadian Urban Areas and Abbreviations for
a list of region names and their abbreviations.

% For a list of File Name abbreviations, refer to Appendix D: Standard Classification (SIC) Codes.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
Not to be disclosed



[0 2004 DMTI Spatial Inc.

File Names of EPOI Look Up Tables
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Look up tables contain information such as; the number of beds in a hospital, the location code of an
airport, and the grade range taught within a school. Look up tables are linked to the main table via the
POI_ID field. For example, a record in the POI database that has an EPOI_TYPE = POL (Police
Services) links via the POI_ID field to the “pol” (Police Services) look up table.

EPOI and EPOI Look Up Table Examples

EPOI File EPOI Look Up Table |Description

OnJ.TXT OnJ_POL.txt Ontario by SIC Division “J” (Public Administration)

On92.txt On92_POL.txt Ontario by SIC Major Group “92” (Justice, Public Order, And
Safety)

0On9221.txt 0On9221 POL.txt Ontario by SIC Code “9221” (Police Protection)

Enhanced attribution can be found in the following look up tables.

EPOI_TYPE
Classification

EPOI_TYPE Description

acc Accommodation

aer Aerodromes

bor Border Crossings & Customs Offices
car Car Rental Agencies

cin Cinemas

cpl Car Pool Parking Lots
edu Education

fin Financial Institutions

gas Gasoline Service Stations
glf Golf Courses

her Health Care

pol Police Services

tol Toll Booths

tou Tourist

wgh Weigh Stations

www.dmtispatial.com

Proprietary and Confidential to DMTI Spatial

Not to be disclosed




[0 2004 DMTI Spatial Inc.

File Structure and Content
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EPOI File Structure

Field Name Field Type Field Size |Field Description

POI ID Character 15 Unique ID

NAME Character 150 Name

UNIT_SUITE Character 25 Unit or Suite #

ADDRESS Character 45 Address

DELIV_MODE Character 25 General Delivery Address (i.e. PO BOX)

CITY Character 68 City or Municipality

PROV Character 2 Province

POST_CODE Character 7 Postal Code

LOCATION Character 100 Description of location

PHONE Character 15 Phone Number

FAX Character 15 Fax Number

TOLL FREE Character 15 Toll Free Number

EPOI TYPE Character 3 Three letter abbreviation of EPOI type

CAF Character 15 Common Address Flag

SIC 1 Character 8 Standard Industrial Classification - Primary

SIC 2 Character te] Standard Industrial Classification

SIC 3 Character te] Standard Industrial Classification

SIC 4 Character te] Standard Industrial Classification

SIC 5 Character 8 Standard Industrial Classification

SIC_6 Character 8 Standard Industrial Classification

SIC_ DIV Character 1 Standard Industrial Classification Division Group
SIC_MJ_GRP Character 2 Standard Industrial Classification Major Group
X Number Longitude

Y Number Latitude

PREC_CODE Character 2 Precision code indicating accuracy of geocoded point
ATTRIBCODE Character 2 Attribution code indicating the accuracy of attribute data

www.dmtispatial.com
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Common Address Flag (CAF)

It is common for businesses or other recreational facilities to share addresses, for example in skyscrapers
or shopping centers. The EPOI product has a feature that allows users to identify records that have
common addresses. A group by query on the CAF field will allow a user to extract a single record by
address. The CAF is an alphanumeric code that is unique to a unique address.

NAME ADDRESS SIC PHONE |[CAF

Business 1 10 Main St. A 1 ADD1
Business 2 10 Main St. B 2 ADD1
Business 3 10 Main St. C 3 ADD1
Business 4 1 King St. D 4 ADD2
Business 5 1 King St. E 5 ADD2

The CAF is only applied to records that have an address. Some DMTI-sourced records (AttribCode = “1")
do not have an address and therefore the CAF field is blank.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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Precision Code (PREC_CODE)
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Value

Description

Centroid of 1:50 000 NTDB feature or placed via Orthorectified photo

Block-face representative point from CanMap streets - High precision

Block-face representative point from CanMap streets - Lower precision

Postal Code - Block-face representative point

Postal Code - EA Centroid / FSA Centroid

OO WIN|F

Municipal Centroid

Attribution Code (ATTRIBCODE)

Value Description

1 DMT]I Spatial sourcing

2 Other sourcing — High confidence (Validated by DMTI Spatial)

3 Other sourcing — Lower confidence (Not validated by DMTI Spatial)
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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EPOI Look Up Table Specifications

Look Up Tables link to the main database via EPOI_TYPE and POI_ID for enhanced attribution.
Enhanced attribution can be found in the following look up tables.

EPOI_TYPE EPOI_TYPE Description
Classification

acc Accommodation

aer Aerodromes

bor Border Crossings & Customs Offices
car Car Rental Agencies

cin Cinemas

cpl Car Pool Parking Lots
edu Education

fin Financial Institutions

gas Gasoline Service Stations
glf Golf Courses

hcr Health Care

pol Police Services

tol Toll Booths

tou Tourist

wgh Weigh Stations

SIC Look Up Tables link to the main database via SIC Division or SIC Major Group.

Look Up Table Look Up Table Description
sic_mjgrp_desc SIC Major Group Descriptions
sic_div_desc SIC Division Descriptions
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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The accommodation layer includes hotels, motels, and inns.

File Structure

Field Name Field Type [Field Size Field Description

POI ID Character 15 Unique ID (link to main POI database)
EPOI TYPE Character 3 Point of Interest Classification

CHAIN Character 100 Accommodation Chain

www.dmtispatial.com
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Aerodromes (aer)
The aerodromes layer includes airports, heliports, and water aerodromes.*

File Structure

Field Name Field Type [Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)

EPOI_TYPE Character 3 Point of Interest Classification

ICAO_CODE Character 4 Location Indicator assigned by Transport Canada and the
U.S. Federal Aviation Administration (4 character)

IATA_CODE Character 3 Location indicator assigned by Transport Canada and the
U.S. Federal Aviation Administration (3 character)

AER_TYPE Character 10 Type of Aerodrome

STATUS Character 10 Operational Status of Aerodrome. Indicates if the
aerodrome is operational or abandoned.

NAME_ALIAS |Character 125 Alternate name of Aerodrome

X1 Number Longitude of first or main entrance point (Terminal 1)

Y1 Number Latitude of first or main entrance point (Terminal 1)

X2 Number Longitude of second entrance point (Terminal 2)

Y2 Number Latitude of second entrance point (Terminal 2)

X3 Number Longitude of third entrance point (Terminal 3)

Y3 Number Latitude of third entrance point (Terminal 3)

Contents

AER_TYPE Description

LAND Aerodromes that provide an advantage for the aviation community are included. This
includes aerodromes that are open to the public, are used by more than one aircraft
and have a telephone available for users of the aerodrome

WATER Water aerodromes that provide an advantage for the aviation community are included,
typically this includes aerodromes that are open to the public, are used by more than
one aircraft, have an area for docking or beaching with tie downs and have a
telephone available for users of the aerodrome

Name and Name_Alias

The Name field contains the names of aerodromes and indicates what communities they may serve. The
Name_Alias field provides an alias for the aerodrome. For example:

Name City Name Alias

Toronto/Lester B. Pearson Intl Toronto Lester B Pearson International Airport
Montréal/St-Hubert Montréal Aeroport de Saint-Hubert
Calgary/Springbank Calgary Calgary Springbank Airport

* Source: Geomatics Canada, Canada Flight Supplement and Canada Water Aerodrome Supplement (WAS), March 2003

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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The Borders Crossings and Customs Offices layer includes independent offices, subordinate offices,
service sites, and warehouses.

File Structure

Field Name Field Type [Field Size Field Description
POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification
BOR TYPE Character 10 Indlc_ates _|f a port is an Independent, a Subordinate or a
- Service Site
PORT_NO Character 5 The number of the Independent Port
REP TO Character a5 The name and numl_)er o_f the Independent Port that a
- Subordinate or Service site reports to
Indicates if a portis a HUB or not. A HUB is an
HUB Character 1 independent office to which a subordinate office would
report.
SERVICES Character 45 Types of services available at that port5
US PORT Character 20 Name of the _US Customs Office opposite to the Canadian
- Customs Office
Contents
BOR_TYPE Description
IND Independent Offices
SER Service Sites
SUB Subordinate Offices

s Detailed information regarding customs operations, the hours and types of services available at custom offices, definitions of
terms, and abbreviations used in the Services field, can be found in Appendix E: Border Crossings and Customs Offices.

www.dmtispatial.com
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Car Rental Agencies (car)

The Car Rental Agencies layer includes the following Car Rental Agencies: Alamo, Avis, Budget,
Discount, Enterprise, Hertz, National and Thrifty.

File Structure

Field Name Field Type [Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification

CHAIN Character 100 Car Rental Chain

LOC CODE Character 10 Unique ldentifier for a branch within a chain
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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Cinemas (cin)
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The cinema layer contains cinemas across Canada.

File Structure

Field Name Field Type [Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Paint of Interest Classification
SCREEN_NO [Character 5 Number of screens in given theatre
PHONE_2 Character 15 Second phone number

www.dmtispatial.com
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Car Pool Parking Lots (cpl)

Page 18

The Car Pool Parking Lots layer indicates the name, exit number, and location of Car Pool Parking Lots
on the Major Expressways. This layer provides data for Ontario only.

File Structure

Field Name Field Type [Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification

EXIT_NUM Character 5 Hwy exit number at location of Car Pool Lot
DIRECTION Character 2 Direction of Hwy Car Pool Lot

Contents

DIRECTION Description

EW East & West

www.dmtispatial.com
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The Education layer includes Elementary Schools, High Schools, Colleges, Cégeps and Universities.

File Structure

Field Name Field Type |Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)

EPOI_TYPE Character 3 Point of Interest Classification

EDU_TYPE Character 10 Education Point of Interest Classification

DISTRICT Character 100 District where the facility resides

LEVEL Character 10 Teaching Level

LANGUAGE Character 10 Predominate or language-only type Some educational
facilities use two languages to teach, but one is usually
predominant. The dominant language is represented first.

GRADES Character 10 Grade range

Contents

EDU_TYPE |Description

CG Cégep

CL College

FN First Nations

P Public

PR Private/Independent

S Catholic (Separate)

SN Special Needs

uv University

LANGUAGE |Description

E English

F French

H Hebrew

G German

U Ukrainian

C Cree

FIE French & English

E/F English & French

E/H English & Hebrew

E/G English & German

E/U English & Ukrainian

LEVEL GRADES Description

J K-6 Junior

I 7-8 Intermediate

S 9-12 Senior

JN K-8 Junior/Intermediate

I/S 7-12 Intermediate/Senior

JNIS K-12 Junior/Intermediate/Senior

www.dmtispatial.com
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Financial Institutions (fin)

The Financial Institutions layer includes financial institutions belonging to one of the following three
groups: (1) Banks, (2) Credit Unions and Caisses Populaires, (3) Trust Companies, Loan Companies, and
Other Deposit-Taking Institutions.

File Structure

Field Name Field Type Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification
FIN_TYPE Character 70 Type of Payment Association®

®a complete listing of financial institutions, and their corresponding FIN_TYPE classification is found in Appendix F: Canadian
Payments Association Classification.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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Gasoline Service Stations (gas)

The Gasoline Service Stations layer is comprised of six different gas companies: Husky, Irving,
PetroCanada, Pioneer, Shell, and Sunoco. Pioneer and Sunoco gas stations are provided for Ontario
only.

File Structure

Field Name Field Type Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI_TYPE Character 3 Point of Interest Classification

CHAIN Character 100 Gas Station Chain

PROPANE Character 3 Propane Available

DIESEL Character 3 Diesel Available
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Golf Courses (glf)
The Golf Courses layer contains Private and Public golf courses.

File Structure

Field Name Field Size |Field Type Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification

NUM HOLE Character 5 Number of Holes at Golf Course

GLF TYPE Character 15 Golf Course Point of Interest Classification
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Health Care (hcr)

The Health Care layer includes Hospitals, Long-Term Care Centers, Nursing Stations, Outpatient Clinics
and Community Health Centers.

File Structure

Field Name Field Type |Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification
TOTAL_BEDS Character 5 Total number of beds

HCR _TYPE Character 1 Health Care Point of Interest Classification
Contents

HCR_TYPE Description

H Acute Care Hospital

L Long-Term Care Center

N Nursing Station

0] Outpatient Clinic

C Community Health Center
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Police Services (pol)’

The Police Services layer includes the Ontario Provincial Police (OPP), Royal Canadian Mounted Police
(RCMP), Sireté du Québec (SQ), the Royal Newfoundland Constabulary (RNC), and other municipal
police services.?

File Structure

Field Name Field Type |Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification
STN_ADMIN Character 70 Police Station or Administrator
POL_TYPE Character 10 Police Service Point of Interest Classification
Contents

POL_TYPE Description

MUN Municipal Police Service

OPP Ontario Provincial Police

RNC Royal Newfoundland Constabulary

RCMP Royal Canadian Mounted Police

SQ Sdreté du Québec

’ Source: CPIC National Directory, Canadian Police Information Centre, 2002.

8 A complete listing of abbreviations and definitions (English/ French) used in the Police Services layer is found in Appendix G :
CPIC National Directory.
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SIC Division Descriptions (sic_div_desc)
The SIC Division Description table includes the description of all SIC Divisions that exist in the file.

File Structure

Field Name Field Type |Field Size Field Description
SIC_DIV Character 1 SIC Division Group
DESCRIPTION Character 150 Description of SIC Division
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SIC Major Group Descriptions (sic_mjgrp_desc)

The SIC Major Group Description table includes the description of all SIC Major Groups that exist in the
file.

File Structure

Field Name Field Type |Field Size Field Description

SIC_MJ _GRP Character 2 SIC Major Group
DESCRIPTION Character 150 Description of SIC Major Group
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Shopping Centers (shp)
The Shopping Centers layer includes over 2000 shopping centers across Canada.

Note: There is no look up table for the SHP layer. All relevant information is found in the main table.
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Ski Centers (ski)
The Ski Centers layer is comprised of over 200 skiing facilities across Canada.

Note: There is no look up table for the SKI layer. All relevant information is found in the main table.
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Toll Booths (tol)

Page 29

The Toll Booths layer indicates the name and location of Toll Booths.

File Structure

Field Name |[Field Type Field Size Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE |Character 3 Point of Interest Classification

DIRECTION |Character 2 Direction of road that toll booth is located on
Contents

DIRECTION |Description

E East

\"\Y West

N North

S South
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Tourist (tou)

Inc.
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The Tourist layer includes categories such as Art Galleries, Attractions, Fishing Resorts, Historic Sites,
Museums, Science Centres, Tourist Information Booths, and Zoos.

File Structure

Field Name Field Type Field Size Field Description
POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Point of Interest Classification
TOU_TYPE Character 5 Tourist Point of Interest Classification
SEASON Character 50 Season that Tourist POl is open
Content
TOU_TYPE
TOU_TYPE Description TOU_TYPE Description
ACH Archive LIB Library
ADV Outdoor Adventure MOV IMAX Movie Theatre
Company/Tour MUS Museum
AQU Aquarium NAT Nature Preserve/Conservatory
ATT Attraction OBS Observatory
BCH Beach ORG Organization related to Arts
CAS Casino and Culture
CEC Cultural or Environmental PNT Planetarium
Education Center PRK Park
CuL Cultural Center RLG Religious Institution
DFS Duty-Free Shop SCI Science Centre
FSH Fishing Lodge/Camp SCN Scenic Site/Trail/Area
GAL Art Gallery SKI Ski Resort/Facility
GDN Garden TIB Tourist Information Board
GSV Government Services WTS Water Tour/Cruise
HIS Historic Site/Park/Location 700 700
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Weigh Stations

The weigh stations layer (at a minimum) contains the Name and Address (if applicable) of each weigh

al Inc.

(wgh)

station as well as the site type (permanent or portable scale).

File Structure

Field Name Field Size |Field Type Field Description

POI_ID Character 15 Unique ID (link to main EPOI database)
EPOI TYPE Character 3 Classification of the EPOI

DIRECTION Character 2 Indicates the direction of road scale is on
HOURS Character 20 Hours of operation

YEAR_ROUND [Logical Year Round Operation

RESTROOM Logical Restrooms available

WGH_TYPE Character 10 Weigh Station Point of Interest Classification
AVION401 Logical Avion 401 automated clearance system
Contents

DIRECTION |Description

N North

S South

E East

W West

0] Ouest

NS North & South (can be accessed from either direction)

EW East & West (can be accessed from either direction)

WGH_Type

Value Description

Perm Permanent Scale

Port Portable Scale
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Appendix A: Importing EPOI Data in GIS Software

Maplinfo
Creating a MapInfo (.tab) table |

1. Open Mapinfo. -
2. File > Open Table > Select EPOL.txt file and double-click. Drelimiter
3. Indialog box, for “Delimited ASCII Information” choose " Tah * Other: I_

‘Other’ (comma), the ‘File Character Set’ should be

“Windows US & W. Europe (“ANSI”)", and check off the File Character Set:

Use First Line for Column Titles. See Figure 1. [windows US & w. Europe [&NSI"] =
4. Click OK.
5. File > Save Copy As...choose folder to save file. ¥ Use First Line for Calumn Titles

6. Open the new .tab file.

] 4 I Cancel Help I

Creating MapInfo Graphics from Coordinate Fields

7. Table > Create Points > Select EPOL.tab file Figure 1: Delimited ASCII Information
8. Adjust the symbol size, colour, and shape by selecting
“Symbol Style”.

9. Choose the “x” field in the ‘Get X Coordinates from Column’ in the drop down box.

10. Choose the “y” field in the ‘Get Y Coordinates from Column’ in the drop down box.

11. Click on Projection, select the Category (Longitude/Latitude) and the Category Member
(Longitude/Latitude (NAD83))

12. Click OK.
Creating Mapinfo Lookup tables Main EPOI table EPOI look up table
13. Repeat steps 1 to 6
Linking the EPOI table to the EPOI Lookup tables M =
14. Open the EPOI table and the EPOI look up Geleci Coharn |, / { Tbde %]
tables in Maplinfo
15. Select Query > SQL select. \ ot 2]
16. Clilck totrrl1 “fré)lgno'll'?blljelzs" ngtr?mlj clli(ck “'[aslles”, s [67A. BTA_six |I.'|:|-r.'1:l.'-|. +|
select the able and the look up table - _ — m i
17. Click on “where Condition” box, enter the B s A PN ID-GTA_ALC PO —
condition so that the POI_ID from each table is |‘“'*'“'- j!
equal.
18. Click on “into Table Named” box and name the firon by Cnlurrs: |
new file. See Figure 2. Drchs by Cokrne: | SmTutHul
nio TablwMamed [G74_Acoorecaon ——
+ Baowse Pasaly
[ ok | come | ow | vew | wes |
Figure 2: Linking the EPOI table to the EPOI Lookup
tables
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ArcView 3.x

Opening txt file(s) and making ArcView files (*.shp)
1. Open ArcView > New Project as a blank project.
2. From the Project Window, click on ‘Tables’. Click “Add”. Change the ‘List Files of Type’ to
“Delimited Text (*.txt), then navigate to the EPOI.txt file(s). Click OK.

W 2 s Talble
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| = udata'vol her amp epston
el 10 i - [ o Ll
=
=
=
=

= =
= ) ]
= gy ]
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T e

or 8T et = | =
Liet Py ol Tpps Doy

Dopbrmad Timd 1704 = |e =]

FO0000PEE

SIASE |® o]

@ I me—_

Figure 3: Creating ArcView files

Creating Graphics from Coordinate Fields

3. In Project Window, click ‘Views'. Press “New” to add a view.

4. Select View > Add Event Theme. Select the correct table, and X/Y coordinate fields from the
EPOI.txt file. Click OK.

5. Inthe View select the EPOI.txt layer to make the layer active.

6. Select Theme > Convert to Shapefile > Navigate to the location where the files will be saved.
Name the file and Click OK. When ArcView asks to add the shapefile as a theme to the view,
Press YES. The new theme with the .shp extension will appear in the view.

Creating Projection Datum Metadata (*.prj files):

7. In the same project, from the Menu > File > Extensions. Scroll down to Projection Utility Wizard,
click on the checkbox and Click OK.

8. File > ArcView Projection Utility. In Step 1, select the shape file and press Next. In Step 2, the
‘Coordinate System Type’ should be “Geographic”. From the ‘Name’ dropdown box, select
“GCS_North_American_1983 [4269]", and the units in “Degree [9102]", then press Next. ArcView
will ask to save the coordinate system information, press Yes and a Project file (*.prj) will be
created with the shape files. Cancel out of the Utility. To continue would actually re-project the
files.

Opening Lookup tables in ArcView:
9. In the same project, click from the Project Window — Tables. Press Add to bring in the lookup
table. Click Open to see the database.
10. File — Export — this will convert the text file to a dBASE format for ArcView. Select the location to
save and press OK.
11. The text version of the lookup table can be deleted from the project. Open the new dBASE file.
12. Repeat for each lookup table as required.
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Linking Lookup tables to the main EPOI table

Page 34

To view the main EPOI table linked to the Look up tables, the files should be manually joined. To join the

files use the following directions:

13. View both the main EPOI table and the Look up table (attribute tables)

14. Click on the POI_ID fields from both the main EPOI table and the Look up table

15. Click on the Join button (or choose Join from the Table menu).

16. Additional Look up tables can be joined, so that many tables’ attributes can be shown at one time.
To undo the joins between the tables, click on the attribute table, making it active, and from the

‘Table’ menu select ‘Remove All Joins’.

ArcGIS 8.1

iy beeke: ool ppedrnd] Ackchlaorial data bo B lagei's altibide Labla 20 o0 Can

Opening txt file(s) and Creating ArcMap files: b mxample, sombolize the Lysrs feshuaes using this dala.

1. Start with a new empty map. Click OK.
2. File > Add Data > navigate to the EPOI.txt

‘e'haat dioe pows wanl 1o join bo B laper

files and Click Add. | o aitriutes hom = tatle =

Note: “ON” is an SQL statement in ArcGIS and
therefore ON.txt cannot be opened and must be
renamed as ONT.txt. The renaming of this file
will not affect the link to the Ontario lookup table.

Creating Graphics from Coordinate Fields:

3. Tools > Add X, Y Data > choose the table
and the X, Y fields.

4. Choose the coordinate system by clicking
Edit. Then from ‘Select Coordinate System’,
select Geographical Coordinate System, then
North America, then North American Datum
1983. Click Add, then Apply, then OK. A
project file (*.prj) is created containing the
coordinate information.

5. Make the event theme active (ie. EPOLl.txt
Events).

6. Right click on the ‘Events’ theme, choose
‘Data’, then ‘Export Data’. Export all
features. Click on the ‘Use the same
Coordinate System as the data frame’ button.
Browse to specify where the theme will be
stored. Click OK.

1, Choeogae tha Fredd i this: e Sai T goin vall be based orc

POI_IC -

£ Chooss the Labls ko poir bo s Lagsr, ot load ihe Labls from. disk.

{OM_BE11 12 = ﬂ

[ Ghiows the attibute tables of layes in this st

3 Choose the fsld in Hhe tabls 2o Base this join on
{FOI_ID:

X

About oring data... | [ o | Cancel |

7. ArcMap will ask to add the layer to the view.
Click Yes. Remove the ‘Events’ theme.

Figure 4: Creating graphics from coordinate fields

Opening Lookup Tables in ArcMap

8. Repeat the first two steps under “Opening txt files and creating ArcMap files” to open the Lookup
tables. Right click on the Lookup table and select ‘Open’ to view.

Linking Lookup tables to the main EPOI table

To view the main EPOI table linked to the Look up tables, the files must be manually joined together.
9. Add both the main EPOI table and Lookup table to the Layers. Right click the Lookup table and

select ‘Joins and Relates’ > ‘Join’.

10. Choose the field the join will be based on (i.e. POI_ID), then select the table to join too, and Click

OK.
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Appendix B: Provincial and Territorial Abbreviations and Codes?®

The provincial/territorial names, abbreviations and numeric codes reflect those in effect on January 1,
2001 with the exception of the name change of the province of Newfoundland and Labrador (previously
Newfoundland), which came into effect on December 6, 2001. Newfoundland and Labrador was
recognized by the alpha code NL (formerly NF). There were no changes to the numeric code (10) and
abbreviations for Newfoundland and Labrador.

On April 1, 1999 the Northwest Territories was divided into two territories to create Nunavut Territory. The
province/territory numeric code for Nunavut is 62 whereas the code for the Northwest Territories remained

at 61. On December 18, 2000, Canada Post has introduced a new alpha code (NU) for Nunavut.

Province/Territory (English) |Province/Territory (French) Abbreviation*|Numeric Code
Alberta Alberta AB 48
British Columbia Colombie-Britannique BC 59
Manitoba Manitoba MB 46
New Brunswick Nouveau-Brunswick NB 13
Newfoundland and Labrador  [Terre-Neuve-et-Labrador NL 10
Nova Scotia Nouvelle-Ecosse NS 61
Northwest Territories Territoires du Nord-Ouest NT 12
Nunavut Nunavut NU 62
Ontario Ontario ON 35
Prince Edward Island lle-du-Prince-Edouard PE 11
Québec Québec QC 24
Saskatchewan Saskatchewan SK 47
Yukon 'Yukon YT 60

® Source: Statistics Canada, Standard Geographical Classification (SGC) 2001

1% Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002
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Appendix C: Canadian Urban Areas and Abbreviations

Canadian urban areas are based upon DMTI’s topographic coverage areas. The following table is a
partial list of urban areas and their abbreviations. For a complete listing of Canadian urban areas refer to
the CANTtop file located in the Canada Directory or for information regarding other areas contact DMTI
Spatial.

Province Topographic Coverage Area Abbreviation
AB Calgary CLGRY
AB Edmonton EDMNT
BC \Vancouver VNCVR
BC Victoria VCTRA
MB \Winnipeg WINPG
NB Fredericton FRDTN
NB Saint John STJON
NL Labrador City LBDRC
NL St. John's STJHN
NS Halifax HALFX
NT Yellowknife YLKNF
NU Igaluit IQALT
ON Greater Toronto Area GTA
ON Hamilton Niagara HAMNG
ON Ottawa OTAWA
PE Charlottetown CHLTN
QC Hull HULL
QC Montreal MNTRL
QC Quebec City QBCTY
SK Regina RGNA
YT \Whitehorse WTHRS
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Appendix D: Standard Industrial Classification Codes

What is an SIC Code?

Standard Industrial Classification (SIC) codes are four digit numerical codes that were established in 1987
by the U.S. Government. The codes were assigned to businesses to group and identify their primary area
of business activity and to facilitate the collection of economic data for statistical analysis by federal, state,
and private organizations. The SIC code classifications cover all economic related activities including
agriculture, forestry & fishing; mining; construction; manufacturing; transportation, communications,
electric, gas, and sanitary services; wholesale trade; retail trade; finance, insurance, real estate; health,

education, recreation and other services; and public administration.

SIC Division

SIC Division is represented by a single letter, for example Division G refers to Retail Trade. Each Division

represents a broad area of economic activity:

Division |Description SIC Range
A IAgriculture, Forestry, And Fishing 01 to 09
B Mining 10to 14
C Construction 15t0 17
D Manufacturing 20 to 39
E Transportation, Communications, Electric, Gas, And Sanitary Services 40 to 49
F \Wholesale Trade 50 to 51
G Retail Trade 52 to 59
H Finance, Insurance, And Real Estate 60 to 67
I Services 70 to 88
J Public Administration 91 to 99
K Unclassified 00

SIC Major Group

SIC Major Group represents the first two digits of the code for example, Major Group 80 refers to Health

Services. Each Major Group represents a sector or industry group:

Major Group |Description SIC Range

01 IAgricultural Production Crops 0111 to 0191
02 Agricultural Production Livestock And Animal Specialties 0211 to 0291
07 Agricultural Services 0711 to 0783
08 Forestry 0811 to 0851
09 Fishing, Hunting, And Trapping 0911 to 0971
10 Metal Mining 1011 to 1099
12 Coal Mining 1221 to 1241
13 Oil And Gas Extraction 1311 to 1389
14 Mining And Quarrying Of Nonmetallic Minerals, Except Fuels 1411 to 1499
15 Building Construction General Contractors And Operative Builders 1521 to 1542
16 Heavy Construction Other Than Building Construction Contractors 1611 to 1629
17 Construction Special Trade Contractors 1711 to 1799
20 Food And Kindred Products 2011 to 2099
21 Tobacco Products 2111 to 2141
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Major Group

Description

SIC Range

22

Textile Mill Products

2211 to 2299

Apparel And Other Finished Products Made From Fabrics And Similar

23 Materials 2311 to 2399
24 Lumber And Wood Products, Except Furniture 2411 to 2499
25 Furniture And Fixtures 2511 to 2599
26 Paper And Allied Products 2611 to 2679
27 Printing, Publishing, And Allied Industries 2711 to 2796
28 Chemicals And Allied Products 2812 to 2899
29 Petroleum Refining And Related Industries 2911 to 2999
30 Rubber And Miscellaneous Plastics Products 3011 to 3089
31 Leather And Leather Products 3111 to 3199
32 Stone, Clay, Glass, And Concrete Products 3211 to 3299
33 Primary Metal Industries 3312 to 3399
Fabricated Metal Products, Except Machinery And Transportation
34 Equipment 3411 to 3499
35 Industrial And Commercial Machinery And Computer Equipment 3511 to 3599
Electronic And Other Electrical Equipment And Components, Except
36 Computer Equipment 3612 to 3699
37 Transportation Equipment 3711 to 3799
Measuring, Analyzing, And Controlling Instruments; Photographic,
38 Medical And Optical Goods; Watches And Clocks 3812 to 3873
39 Miscellaneous Manufacturing Industries 3911 to 3999
40 Major Group 40: Railroad Transportation 4011 to 4013
Local And Suburban Transit And Interurban Highway Passenger
41 Transportation 4111 to 4173
42 Motor Freight Transportation And Warehousing 4212 to 4231
43 United States Postal Service 4311 to 4311
44 \Water Transportation 4412 to 4499
45 Transportation By Air 4512 to 4581
46 Pipelines, Except Natural Gas 4612 to 4619
a7 Transportation Services 4724 to 4789
48 Communications 4812 to 4899
49 Electric, Gas, And Sanitary Services 4911 to 4971
50 \Wholesale Trade-durable Goods 5012 to 5099
51 \Wholesale Trade-non-durable Goods 5111 to 5199
Building Materials, Hardware, Garden Supply, And Mobile Home
52 Dealers 5211 to 5271
53 General Merchandise Stores 5311 to 5399
54 Food Stores 5411 to 5499
55 IAutomotive Dealers And Gasoline Service Stations 5511 to 5599
56 IApparel And Accessory Stores 5611 to 5699
57 Home Furniture, Furnishings, And Equipment Stores 5712 to 5736
58 Eating And Drinking Places 5812 to 5813
59 Miscellaneous Retall 5912 to 5999
60 Depository Institutions 6011 to 6099
61 Non-depository Credit Institutions 6111 to 6163
62 Security And Commaodity Brokers, Dealers, Exchanges, And Services 6211 to 6289
63 Insurance Carriers 6311 to 6399
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Major Group [Description SIC Range
64 Insurance Agents, Brokers, And Service 6411 to 6411
65 Real Estate 6512 to 6553
67 Holding And Other Investment Offices 6712 to 6799
70 Hotels, Rooming Houses, Camps, And Other Lodging Places 7011 to 7041
72 Personal Services 7211 to 7299
73 Business Services 7311 to 7389
75 IAutomotive Repair, Services, And Parking 7513 to 7549
76 Miscellaneous Repair Services 7622 to 7699
78 Motion Pictures 7812 to 7841
79 Amusement And Recreation Services 7911 to 7999
80 Health Services 8011 to 8099
81 Legal Services 8111 to 8111
82 Educational Services 8211 to 8299
83 Social Services 8322 to 8399
84 Museums, Art Galleries, And Botanical And Zoological Gardens 8412 to 8422
86 Membership Organizations 8611 to 8699
Engineering, Accounting, Research, Management, And Related
87 Services 8711 to 8748
88 Private Households 8811 to 8811
91 Executive, Legislative, And General Government, Except Finance 9111 to 9199
92 Justice, Public Order, And Safety 9111 to 9229
93 Public Finance, Taxation, And Monetary Policy 9311 to 9311
94 IAdministration Of Human Resource Programs 9411 to 9451
95 IAdministration Of Environmental Quality And Housing Programs 9511 to 9532
96 IAdministration Of Economic Programs 9611 to 9661
97 National Security And International Affairs 9711 to 9721
99 No classifiable Establishments 9999 to 9999
00 Unclassified 0000 to 0000
SIC Code

SIC Code represents the four digits of the code, for example SIC Code 5431 refers to Fruit and Vegetable
Markets. Each SIC Code represents specific products or services for a business:

SIC Code Description of SIC Code
0111 \Wheat

0112 Rice

0115 Corn

0116 Soybeans

0119 Cash Grains, nec

0131 Cotton

0132 Tobacco

0133 Sugarcane & sugar beets
0134 Irish Potatoes

0139 Field Crops, Except Cash Grains, nec
0161 \Vegetables And Melons
0171 Berry Crops

0172 Grapes
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SIC Code Description of SIC Code

0173 Tree Nuts

0174 Citrus Fruits

0175 Deciduous Tree Fruits

0179 Fruits & tree nuts, nec

0181 Ornamental Floriculture And Nursery Products
0182 Food Crops Grown Under Cover

0191 General Farms, Primarily Crop

0211 Beef Cattle Feedlots

0212 Beef Cattle, Except Feedlots

0213 Hogs

0214 Sheep & goats

0219 General Livestock, Except Dairy And Poultry
0241 Dairy Farms

0251 Broiler, fryer, & roaster chickens

0252 Chicken Eggs

0253 Turkeys & turkey eggs

0254 Poultry Hatcheries

0259 Poultry & eggs, nec

0271 Fur-bearing animals & rabbits

0272 Horses & other equines

0273 Animal Aquaculture

0279 Animal Specialties, nec

0291 General Farms, Primarily Livestock And Animal Specialties
0711 Soil Preparation Services

0721 Crop planting & protecting

0722 Crop Harvesting, Primarily By Machine

0723 Crop Preparation Services For Market, Except Cotton Ginning
0724 Cotton Ginning

0741 \Veterinary Services For Livestock

0742 \Veterinary Services For Animal Specialties
0751 Livestock Services, Exc. Veterinary

0752 IAnimal Specialty Services, Except Veterinary
0761 Farm Labor Contractors And Crew Leaders
0762 Farm Management Services

0781 Landscape counseling & planning

0782 Lawn & garden services

0783 Ornamental shrub & tree services

0811 Timber Tracts

0831 Forest Nurseries And Gathering Of Forest Products
0851 Forestry Services

0912 Finfish

0913 Shellfish

0919 Miscellaneous Marine Products

0921 Fish hatcheries & preserves

0971 Hunting, Trapping, Game Propagation

1011 Iron Ores

1021 Copper Ores
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SIC Code Description of SIC Code
1031 Lead & zinc ores
1041 Gold Ores
1044 Silver Ores
1061 Ferroalloy Ores, Except Vanadium
1081 Metal Mining Services
1094 Uranium-Radium-Vanadium Ores
1099 Miscellaneous Metal Ores, nec
1221 Bituminous coal & lignite--surface
1222 Bituminous coal underground
1231 IAnthracite Mining
1241 Coal Mining Services
1311 Crude petroleum & natural gas
1321 Natural Gas Liquids
1381 Drilling oil & gas wells
1382 Oil & gas exploration services
1389 Oil & gas field services, nec
1411 Dimension Stone
1422 Crushed & broken limestone
1423 Crushed & broken granite
1429 Crushed & broken stone, nec
1442 Construction sand & gravel
1446 Industrial Sand
1455 Kaolin & ball clay
1459 Clay & related minerals, nec
1474 Potash, soda, & borate minerals
1475 Phosphate Rock
1479 Chemical & fertilizer mining, nec
1481 Nonmetallic Minerals Services, Except Fuels
1499 Miscellaneous Nonmetallic Minerals, Except Fuels
1521 General Contractors-Single-Family Houses
1522 General Contractors-Residential Buildings, Other Than Single-Family
1531 Operative Builders
1541 Industrial buildings & warehouses
General Contractors-Nonresidential Buildings, Other Than Industrial Buildings And
1542 \Warehouses
1611 Highway & street construction
1622 Bridge, Tunnel, And Elevated Highway Construction
1623 \Water, sewer & utility lines
1629 Heavy Construction, nec
1711 Plumbing, Heating And Air-Conditioning
1721 Painting & paper hanging
1731 Electrical Work
1741 Masonry & other stone work
1742 Plastering, drywall & insulation
1743 Terrazzo, Tile, Marble, And Mosaic Work
1751 Carpentry Work
1752 Floor laying & floor work, nec
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SIC Code Description of SIC Code

1761 Roofing, Siding, And Sheet Metal Work

1771 Concrete Work

1781 \Water Well Drilling

1791 Structural Steel Erection

1793 Glass & glazing work

1794 Excavation Work

1795 \Wrecking & demolition work

1796 Installation Or Erection Of Building Equipment, nec
1799 Special Trade Contractors, nec

2011 Meat Packing Plants

2013 Sausages & other prepared meats

2015 Poultry slaughtering & processing

2021 Creamery Butter

2022 Cheese, natural & processed

2023 Dry, Condensed, And Evaporated Dairy Products
2024 Ice cream & frozen desserts

2026 Fluid Milk

2032 Canned Specialties

2033 Canned fruits & vegetables

2034 Dried And Dehydrated Fruits, Vegetables, And Soup Mixes
2035 Pickles, sauces, & salad dressings

2037 Frozen fruits & vegetables

2038 Frozen Specialties, nec

2041 Flour & other grain mill products

2043 Cereal Breakfast Foods

2044 Rice Milling

2045 Prepared flour mixes & doughs

2046 \Wet Corn Milling

2047 Dog & cat food

2048 Prepared Feeds And Feed Ingredients For Animals And Fowls, Except Dogs And Cats
2051 Bread, cake, & related products

2052 Cookies & crackers

2053 Frozen Bakery Products, Except Bread

2061 Cane Sugar, Except Refining

2062 Cane Sugar Refining

2063 Beet Sugar

2064 Candy And Other Confectionery Products

2066 Chocolate And Cocoa Products

2067 Chewing Gum

2068 Salted And Roasted Nuts And Seeds

2074 Cottonseed Oil Mills

2075 Soybean Oil Mills

2076 \Vegetable Oil Mills, Except Corn, Cottonseed, And Soybean
2077 Animal & marine fats & oils

2079 Edible fats & oils, nec

2082 Malt Beverages

2083 Malt

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial

Not to be disclosed




[0 2004 DMTI Spatial Inc.

Page 43

SIC Code Description of SIC Code

2084 \Wines, brandy, & brandy spirits

2085 Distilled & blended liquors

2086 Bottled & canned soft drinks

2087 Flavoring extracts & syrups, nec

2091 Canned & cured fish & seafoods

2092 Prepared Fresh Or Frozen Fish And Seafoods

2095 Roasted Coffee

2096 Potato Chips, Corn Chips, And Similar Snacks

2097 Ice Mfrs

2098 Macaroni & spaghetti

2099 Food Preparations, nec

2111 Cigarettes

2121 Cigars

2131 Chewing & smoking tobacco

2141 [Tobacco stemming & redrying

2211 Broadwoven Fabric Mills, Cotton

2221 Broadwoven Fabric Mills, Manmade Fiber And Silk
2231 Broadwoven Fabric Mills, Wool (Including Dying And Finishing)
2241 Narrow Fabric And Other Smallwares Mills: Cotton, Wool, Silk, And Manmade Fiber
2251 \Women's Full-Length And Knee-Length Hosiery, Except Socks
2252 Hosiery, nec

2253 Knit Outerwear Mills

2254 Knit Underwear And Nightwear Mills

2257 \Weft Knit Fabric Mills

2258 Lace & warp knit fabric mills

2259 Knitting Mills, nec

2261 Finishers Of Broadwoven Fabrics Of Cotton

2262 Finishers Of Broadwoven Fabrics Of Manmade Fiber And Silk
2269 Finishers Of Textiles, nec

2273 Carpets & rugs

2281 Yarn Spinning Mills

2282 [Throwing & winding mills

2284 Thread Mills

2295 Coated Fabrics, Not Rubberized

2296 Tire cord & fabrics

2297 Non-woven Fabrics

2298 Cordage & twine

2299 Textile Goods, nec

2311 Men's And Boys' Suits, Coats, And Overcoats

2321 Men's And Boys' Shirts, Except Workshirts

2322 Men's And Boys' Underwear And Nightwear

2323 Men's And Boys' Neckwear

2325 Men's And Boys' Separate Trousers And Slacks

2326 Men's And Boys' Work Clothing

2329 Men's And Boys' Clothing, nec

2331 \Women's, Misses', And Juniors' Blouses And Shirts
2335 Women's, Misses', And Juniors' Dresses
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2337 Women's & misses' suits & coats

2339 Women's, Misses', And Juniors' Outerwear, nec
2341 \Women's & children's underwear

2342 Bras, girdles, & allied garments

2353 Hats, caps, & millinery

2361 Girls', Children's And Infants' Dresses, Blouses, And Skirts
2369 Girls', Children's And Infants' Outerwear, nec
2371 Fur Goods

2381 Fabric dress & work gloves

2384 Robes & dressing gowns

2385 \Waterproof Outerwear

2386 Leather & sheep-lined clothing

2387 Apparel Belts

2389 Apparel & accessories, nec

2391 Curtains & draperies

2392 Housefurnishings, Except Curtains And Draperies
2393 Textile Bags

2394 Canvas & related products

2395 Pleating & stitching

2396 IAutomotive & apparel trimmings

2397 Schiffli Machine Embroideries

2399 Fabricated Textile Products, nec

2411 Logging

2421 Sawmills And Planing Mills, General

2426 Hardwood Dimension And Flooring Mills

2429 Special Product Sawmills, nec

2431 Millwork

2434 \Wood Kitchen Cabinets

2435 Hardwood veneer & plywood

2436 Softwood veneer & plywood

2439 Structural Wood Members, nec

2441 Nailed Corner wood boxes & shook

2448 \Wood pallets & skids

2449 \Wood Containers, nec

2451 Mobile Homes

2452 Prefabricated Wood Buildings And Components
2491 \Wood Preserving

2493 Reconstituted Wood Products

2499 \Wood Products, nec

2511 \Wood Household Furniture, Except Upholstered
2512 \Wood Household Furniture, Upholstered

2514 Metal Household Furniture

2515 Mattresses & bedsprings

2517 \Wood TV & radio cabinets

2519 Household Furniture, nec

2521 \Wood Office Furniture

2522 Office Furniture, Except Wood
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2531 Public Building And Related Furniture

2541 \Wood partitions & fixtures

2542 Partitions & fixtures, except wood

2591 Drapery hardware, blinds & shades

2599 Furniture & fixtures, nec

2611 Pulp Mills

2621 Paper Mills

2631 Paperboard Mills

2652 Setup Paperboard Boxes

2653 Corrugated And Solid Fiber Boxes

2655 Fiber Cans, Tubes, Drums, And Similar Products
2656 Sanitary Food Containers, Except Folding

2657 Folding Paperboard Boxes, Including Sanitary
2671 Packaging Paper And Plastics Film, Coated And Laminated
2672 Coated And Laminated Paper, nec

2673 Plastics, Foil, And Coated Paper Bags

2674 Uncoated Paper And Multiwall Bags

2675 Die-Cut Paper And Paperboard And Cardboard
2676 Sanitary Paper Products

2677 Envelopes

2678 Stationery, Tablets, And Related Products

2679 Converted Paper And Paperboard Products, nec
2711 Newspapers: Publishing, Or Publishing And Printing
2721 Periodicals: Publishing, Or Publishing And Printing
2731 Books: Publishing, Or Publishing And Printing
2732 Books Printing

2741 Miscellaneous Publishing

2752 Commercial Printing, Lithographic

2754 Commercial Printing, Gravure

2759 Commercial Printing, nec

2761 Manifold Business Forms

2771 Greeting Cards

2782 Blankbooks & looseleaf binders

2789 Bookbinding & related work

2791 Typesetting

2796 Platemaking And Related Services

2812 Alkalies & chlorine

2813 Industrial Gases

2816 Inorganic Pigments

2819 Industrial Inorganic Chemicals, nec

2821 Plastics materials & resins

2822 Synthetic Rubber

2823 Cellulosic Manmade Fibers

2824 Manmade Organic Fibers, Except Cellulosic
2833 Medicinals & botanicals

2834 Pharmaceutical Preparations

2835 In Vitro And In Vivo Diagnostic Substances
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2836 Biological Products, Exc. Diagnostic Substances
2841 Soap & other detergents

2842 Polishes & sanitation goods

2843 Surface Active Agents, Finishing Agents, Sulfonated Oils, And Assistants
2844 Perfumes, Cosmetics, And Other Toilet Preparations
2851 Paints & allied products

2861 Gum & wood chemicals

2865 Cyclic crudes & intermediates

2869 Industrial Organic Chemicals, nec

2873 Nitrogenous Fertilizers

2874 Phosphatic Fertilizers

2875 Fertilizers, Mixing Only

2879 Pesticides And Agricultural Chemicals, nec

2891 IAdhesives & sealants

2892 Explosives

2893 Printing Ink

2895 Carbon Black

2899 Chemicals And Chemical Preparations, nec

2911 Petroleum Refining

2951 IAsphalt paving mixtures & blocks

2952 Asphalt felts & coatings

2992 Lubricating oils & greases

2999 Petroleum & coal products, nec

3011 Tires & inner tubes

3021 Rubber & plastics footwear

3052 Rubber And Plastics Hose And Belting

3053 Gaskets, Packing And Sealing Devices

3061 Molded, Extruded, And Lathe-Cut Mechanical Rubber Goods
3069 Fabricated Rubber Products, nec

3081 Unsupported Plastics Film And Sheet

3082 Unsupported Plastics Profile Shapes

3083 Laminated Plastics Plate, Sheet, And Profile Shapes
3084 Plastics Pipe

3085 Plastics Bottles

3086 Plastics Foam Products

3087 Custom Compounding Of Purchased Plastic Resins
3088 Plastics Plumbing Fixtures

3089 Plastics Products, nec

3111 Leather tanning & finishing

3131 Boot And Shoe Cut Stock And Findings

3142 House Slippers

3143 Men's Footwear, Except Athletic

3144 \Women's Footwear, Except Athletic

3149 Footwear, Except Rubber, nec

3151 Leather gloves & mittens

3161 Luggage

3171 \Women's handbags & purses

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial

Not to be disclosed




[0 2004 DMTI Spatial Inc. Page 47

SIC Code Description of SIC Code
3172 Personal Leather Goods, Except Woman's Handbags And Purses
3199 Leather Goods, nec
3211 Flat Glass
3221 Glass Containers
3229 Pressed & blown glass, nec
3231 Glass Products Made Of Purchased Glass
3241 Cement, Hydraulic
3251 Brick & structural clay tile
3253 Ceramic wall & floor tile
3255 Clay Refractories
3259 Structural Clay Products, nec
\Vitreous China Plumbing Fixtures And China Earthenware Fittings And Bathroom
3261 IAccessories
3262 \Vitreous China Table And Kitchen Articles
3263 Fine Earthenware (Whiteware) Table And Kitchen Articles
3264 Porcelain Electrical Supplies
3269 Pottery Products, nec
3271 Concrete block & brick
3272 Concrete Products, Except Block And Brick
3273 Ready-Mixed Concrete
3274 Lime
3275 Gypsum Products
3281 Cut stone & stone products
3291 Abrasive Products
3292 IAsbestos Products
3295 Minerals And Earths, Ground Or Otherwise Treated
3296 Mineral Wool
3297 Nonclay Refractories
3299 Nonmetallic Mineral Products, nec
3312 Blast furnaces & steel mills
3313 Electrometallurgical Products, Except Steel
3315 Steel wire & related products
3316 Cold-Rolled Steel Sheet, Strip, And Bars
3317 Steel pipe & tubes
3321 Gray & ductile iron foundries
3322 Malleable Iron Foundries
3324 Steel Investment Foundries
3325 Steel Foundries, nec
3331 Primary Smelting And Refining Of Copper
3334 Primary Production Of Aluminum
3339 Primary Smelting And Refining Of Nonferrous Metals, Except Copper And Aluminum
3341 Secondary Smelting And Refining Of Nonferrous Metals
3351 Rolling, Drawing, And Extruding Of Copper
3353 Aluminum sheet, plate, & foll
3354 Aluminum Extruded Products
3355 IAluminum Rolling And Drawing, nec
3356 Rolling, Drawing, And Extruding Of Nonferrous Metals, Except Copper And Aluminum
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3357 Drawing And Insulating Of Nonferrous Wire
3363 Aluminum Die-Castings

3364 Nonferrous Die-Casting Except Aluminum
3365 Aluminum Foundries

3366 Copper Foundries

3369 Nonferrous Foundries, Except Aluminum And Copper
3398 Metal Heat Treating

3399 Primary Metal Products, nec

3411 Metal Cans

3412 Metal barrels, drums, & pails

3421 Cutlery

3423 Hand & edge tools, nec

3425 Saw blades & handsaws

3429 Hardware, nec

3431 Enameled Iron And Metal Sanitary Ware
3432 Plumbing fixture fittings & trim

3433 Heating Equipment, Except Electric And Warm Air Furnaces
3441 Fabricated Structural Metal

3442 Metal doors, sash, & trim

3443 Fabricated Plate Work (Boiler Shops)

3444 Sheet Metalwork Mfrs

3446 Architectural And Ornamental Metal Work
3448 Prefabricated Metal Buildings And Components
3449 Miscellaneous Structural Metal Work

3451 Screw Machine Products

3452 Bolts, nuts, rivets, & washers

3462 Iron & steel forgings

3463 Nonferrous Forgings

3465 Automotive Stampings

3466 Crowns & closures

3469 Metal Stampings, nec

3471 Plating & polishing

3479 Metal coating & allied services

3482 Small Arms Ammunition

3483 Ammunition, Except For Small Arms

3484 Small Arms

3489 Ordnance & accessories, hec

3491 Industrial Valves

3492 Fluid Power Valves And Hose Fittings

3493 Steel Springs, Except Wire

3494 \Valves And Pipe Fittings, nec

3495 \Wire Springs

3496 Misc. Fabricated Wire Products

3497 Metal Foil And Leaf

3498 Fabricated Pipe And Pipe Fittings

3499 Fabricated Metal Products, nec

3511 Turbines & turbine generator sets
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3519 Internal Combustion Engines, nec

3523 Farm machinery & equipment

3524 Lawn & garden equipment

3531 Construction Machinery And Equipment

3532 Mining Machinery And Equipment, Except Oil And Gas Field Machinery And Equipment
3533 Oil & gas field machinery

3534 Elevators & moving stairways

3535 Conveyors & conveying equipment

3536 Hoists, cranes, & monorails

3537 Industrial trucks & tractors

3541 Machine Tools, Metal Cutting Types

3542 Machine Tools, Metal Forming Types

3543 Industrial Patterns

3544 Special Dies And Tools, Die Sets, Jigs And Fixtures, And Industrial Molds
3545 Cutting Tools, Machine Tool Accessories, And Machinists' Precision Measuring Devices
3546 Power-Driven Handtools

3547 Rolling Mill Machinery And Equipment

3548 Electric And Gas Welding And Soldering Equipment
3549 Metalworking Machinery, nec

3552 Textile Machinery

3553 \Woodworking Machinery

3554 Paper Industries Machinery

3555 Printing Trades Machinery And Equipment

3556 Food Products Machinery

3559 Special Industry Machinery, nec

3561 Pumps & pumping equipment

3562 Ball & roller bearings

3563 Air & gas compressors

3564 Blowers & fans

3565 Packaging Machinery

3566 Speed changers, drives, & gears

3567 Industrial furnaces & ovens

3568 Mechanical Power Transmission Equipment, nec

3569 General Industrial Machinery And Equipment, nec

3571 Electronic Computers

3572 Computer Storage Devices

3575 Computer Terminals

3577 Computer Peripheral Equipment, nec

3578 Calculating & accounting equipment

3579 Office Machines, nec

3581 Automatic Vending Machines

3582 Commercial Laundry, Dry Cleaning, And Pressing Machines
3585 Refrigeration & heating equipment

3586 Measuring & dispensing pumps

3589 Service Industry Machinery, nec

3592 Carburetors, Pistons, Piston Rings, And Valves

3593 Fluid Power Cylinders And Actuators
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3594 Fluid Power Pumps And Motors

3596 Scales & balances, exc. laboratory

3599 Industrial And Commercial Machinery And Equipment, nec
3612 Power, Distribution, And Specialty Transformers

3613 Switchgear & switchboard apparatus

3621 Motors & generators

3624 Carbon & graphite products

3625 Relays & industrial controls

3629 Electrical Industrial Apparatus, nec

3631 Household Cooking Equipment

3632 Household refrigerators & freezers

3633 Household Laundry Equipment

3634 Electric housewares & fans

3635 Household Vacuum Cleaners

3639 Household Appliances, nec

3641 Electric Lamp Bulbs And Tubes

3643 Current-Carrying Wiring Devices

3644 Noncurrent-Carrying Wiring Devices

3645 Residential Electric Lighting Fixtures

3646 Commercial, Industrial, And Institutional Electric Lighting Fixtures
3647 \Vehicular Lighting Equipment

3648 Lighting Equipment, nec

3651 Household audio & video equipment

3652 Prerecorded records & tapes

3661 Telephone & telegraph apparatus

3663 Radio And Television Broadcasting And Communications Equipment
3669 Communications Equipment, nec

3671 Electron Tubes

3672 Printed Circuit Boards

3674 Semiconductors & related devices

3675 Electronic Capacitors

3676 Electronic Resistors

3677 Electronic coils & transformers

3678 Electronic Connectors

3679 Electronic Components, nec

3691 Storage Batteries

3692 Primary batteries, dry & wet

3694 Electrical Equipment For Internal Combustion Engines
3695 Magnetic & optical recording media

3699 Electrical Machinery, Equipment, And Supplies, nec
3711 Motor vehicles & car bodies

3713 Truck & bus bodies

3714 Motor vehicle parts & accessories

3715 [Truck Trailers

3716 Motor Homes

3721 Aircraft

3724 Aircraft engines & engine parts
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3728 Aircraft parts & equipment, nec
3731 Ship building & repairing
3732 Boat building & repairing
3743 Railroad Equipment
3751 Motorcycles, bicycles, & parts
3761 Guided missiles & space vehicles
3764 Space propulsion units & parts
3769 Guided Missile And Space Vehicle Parts And Auxiliary Equipment, nec
3792 Travel Trailers And Campers
3795 Tanks & tank components
3799 Transportation Equipment, nec
3812 Search & navigation equipment
3821 Laboratory apparatus & furniture
IAutomatic Controls For Regulating Residential And Commercial Environments And
3822 Appliances
Industrial Instruments For Measurement, Display, And Control Of Process Variables; And
3823 Related Products
3824 Fluid meters & counting devices
3825 Instruments For Measuring And Testing Of Electricity And Electrical Signals
3826 Laboratory Analytical Instruments
3827 Optical instruments & lenses
3829 Measuring And Controlling Devices, nec
3841 Surgical & medical instruments
3842 Surgical appliances & supplies
3843 Dental equipment & supplies
3844 X-ray apparatus & tubes
3845 Electromedical And Electrotherapeutic Apparatus
3851 Ophthalmic Goods
3861 Photographic equipment & supplies
3873 \Watches, Clocks, Clockwork Operated Devices, And Parts
3911 Jewellery, Precious Metal
3914 Silverware & plated ware
3915 Jewellers' Findings And Materials, And Lapidary Work
3931 Musical Instruments
3942 Dolls & stuffed toys
3944 Games, toys, & children's vehicles
3949 Sporting & athletic goods, nec
3951 Pens & mechanical pencils
3952 Lead pencils & art goods
3953 Marking Devices
3955 Carbon paper & inked ribbons
3961 Costume Jewellery And Costume Novelties, Except Precious Metal
3965 Fasteners, Buttons, Needles, And Pins
3991 Brooms & brushes
3993 Signs & advertising specialties
3995 Burial Caskets
3996 Linoleum, Asphalted-Felt-Base, And Other Hard Surface Floor Coverings, nec
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3999 Manufacturing Industries, nec

4011 Railroads, Line-Haul Operating

4013 Switching & terminal services

4111 Local & suburban transit

4119 Local Passenger Transportation, nec

4121 Taxicabs

4131 Intercity And Rural Bus Transportation

4141 Local Bus Charter Service

4142 Bus Charter Service, Except Local

4151 School Buses

4173 Bus terminal & service facilities

4212 Local Trucking, Without Storage

4213 Trucking except local

4214 Local Trucking With Storage

4215 Courier Services, Except By Air

4221 Farm product warehousing & storage

4222 Refrigerated warehousing & storage

4225 General warehousing & storage

4226 Special warehousing & storage, nec

4231 Terminal And Joint Terminal Maintenance Facilities For Motor Freight Transportation
4311 United States Postal Service

4412 Deep sea foreign transportation of freight

4424 Deep sea domestic transportation of freight

4432 Freight transportation on the Great Lakes

4449 \Water Transportation Of Freight, nec

4481 Deep Sea Passenger Transportation, Ex. Ferry

4482 Ferries

4489 \Water Transportation Of Passengers, nec

4491 Marine Cargo Handling

4492 Towing & tugboat service

4493 Marinas

4499 \Water Transportation Services, nec

4512 Air Transportation, Scheduled

4513 Air Courier Services

4522 Air Transportation, Nonscheduled

4581 Airports, Flying, Fields, And Airport Terminal Services
4612 Crude Petroleum Pipelines

4613 Refined Petroleum Pipelines

4619 Pipelines, nec

4724 Travel Agencies

4725 Tour Operators

4729 IArrangement Of Passenger Transportation, nec

4731 Arrangement Of Transportation Of Freight And Cargo, nec
4741 Rental Of Railroad Cars

4783 Packing & crating

4785 Fixed Facilities And Inspection And Weighing Services For Motor Vehicle Transportation
4789 Transportation Services, nec
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4812 Radiotelephone Communications

4813 Telephone Communications, Except Radio

4822 Telegraph And Other Message Communications
4832 Radio Broadcasting Stations

4833 Television Broadcasting Stations

4841 Cable & other pay TV services

4899 Communication Services, nec

4911 Electric Services

4922 Natural Gas Transmission

4923 Gas transmission & distribution

4924 Natural Gas Distribution

4925 Gas production &/or distribution

4931 Electric & other services combined

4932 Gas & other services combined

4939 Combination Utilities, nec

4941 \Water Supply

4952 Sewerage Systems

4953 Refuse Systems

4959 Sanitary Services, nec

4961 Steam & air-conditioning supply

4971 Irrigation Systems

5012 IAutomobiles & other motor vehicles

5013 Motor vehicle supplies & new parts

5014 Tires & tubes

5015 Motor Vehicle Parts, Used

5021 Furniture

5023 Home Furnishings

5031 Lumber, plywood, & millwork

5032 Brick, Stone, And Related Construction Materials
5033 Roofing, Siding, And Insulation Materials

5039 Construction Materials, nec

5043 Photographic equipment & supplies

5044 Office Equipment

5045 Computers And Computer Peripherals Equipment And Software
5046 Commercial Equipment, nec

5047 Medical & hospital equipment

5048 Ophthalmic Goods

5049 Professional Equipment And Supplies, nec

5051 Metals service centers & offices

5052 Coal & other minerals & ores

5063 Electrical apparatus & equipment

5064 Electrical Appliances, Television And Radios Sets
5065 Electronic parts & equipment

5072 Hardware

5074 Plumbing And Heating Equipment And Supplies (Hydronics)
5075 \Warm air heating & air conditioning

5078 Refrigeration equipment & supplies
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5082 Construction & mining machinery

5083 Farm & garden machinery

5084 Industrial machinery & equipment

5085 Industrial Supplies

5087 Service Establishment Equipment And Supplies
5088 Transportation Equipment And Supplies, Except Motor Vehicles
5091 Sporting And Recreational Goods And Supplies
5092 [Toys, hobby goods & supplies

5093 Scrap & waste materials

5094 Jewellery, Watches, Precious Stones, And Precious Metals
5099 Durable Goods, nec

5111 Printing & writing paper

5112 Stationery & office supplies

5113 Industrial And Personal Service Paper

5122 Drugs, proprietaries, & sundries

5131 Piece Goods, Notions And Other Dry Goods
5136 Men's & boys' clothing

5137 \Women's & children's clothing

5139 Footwear

5141 Groceries, General Line

5142 Packaged Frozen Foods

5143 Dairy Products, Exc. Dried Or Canned

5144 Poultry & poultry products

5145 Confectionery

5146 Fish & seafoods

5147 Meats & meat products

5148 Fresh fruits & vegetables

5149 Groceries & related products, nec

5153 Grain & field beans

5154 Livestock

5159 Farm product raw materials, nec

5162 Plastics Materials And Basic Forms And Shapes
5169 Chemicals And Allied Products, nec

5171 Petroleum Bulk Stations And Terminals

5172 Petroleum And Petroleum Products Wholesalers, Except Bulk Stations And Terminals
5181 Beer & ale

5182 Wine & distilled beverages

5191 Farm Supplies

5192 Books, Periodicals, And Newspapers

5193 Flowers, Nursery Stock And Florists' Supplies
5194 Tobacco & tobacco products

5198 Paints, varnishes, & supplies

5199 Nondurable Goods, nec

5211 Lumber & other building materials

5231 Paint, glass & wallpaper stores

5251 Hardware Stores

5261 Retail nurseries & garden stores
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5271 Mobile Home Dealers

5311 Department Stores

5331 \Variety Stores

5399 Miscellaneous General Merchandise Stores
5411 Grocery Stores

5421 Meat & fish markets

5431 Fruit & vegetable markets

5441 Candy, nut & confectionery stores

5451 Dairy Products Stores

5461 Retail Bakeries

5499 Miscellaneous Food Stores

5511 New & used car dealers

5521 Motor Vehicle Dealers (Used Only)

5531 Auto & home supply stores

5541 Gasoline Service Stations

5551 Boat Dealers

5561 Recreational Vehicle Dealers

5571 Motorcycle Dealers

5599 Automotive Dealers, nec

5611 Men's And Boys' Clothing And Accessory Stores
5621 \Women's Clothing Stores

5632 \Women's Accessory And Specialty Stores
5641 Children's & infants' wear stores

5651 Family Clothing Stores

5661 Shoe Stores

5699 Miscellaneous Apparel And Accessory Stores
5712 Furniture Stores

5713 Floor Covering Stores

5714 Drapery & upholstery stores

5719 Miscellaneous Home Furnishings Stores
5722 Household Appliance Stores

5731 Radio, Television, And Consumer Electronics Stores
5734 Computer And Computer Software Stores
5735 Record And Prerecorded Tape Stores

5736 Musical Instrument Stores

5812 Eating Places

5813 Drinking Places (Alcoholic Beverages)
5912 Drug Stores And Proprietary Stores

5921 Liguor Stores

5932 Used Merchandise Stores

5941 Sporting Goods And Bicycle Shops

5942 Book Stores

5943 Stationery Stores

5944 Jewellery Stores

5945 Hobby, Toy, And Game Shops

5946 Camera And Photographic Supply Stores
5947 Gift, Novelty, And Souvenir Shops
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5948 Luggage And Leather Goods Stores

5949 Sewing, Needlework, And Piece Goods Stores
5961 Catalog And Mail-Order Houses

5962 IAutomatic Merchandising Machine Operators

5963 Direct Selling Establishments

5983 Fuel Oil Dealers

5984 Liguefied Petroleum Gas (Bottled Gas) Dealers
5989 Fuel Dealers, nec

5992 Florists

5993 Tobacco Stores And Stands

5994 News Dealers And Newsstands

5995 Optical Goods Stores

5999 Miscellaneous Retail Stores, nec

6011 Federal Reserve Banks

6019 Central Reserve Depository Institutions, nec

6021 National Commercial Banks

6022 State Commercial Banks

6029 Commercial Banks, nec

6035 Savings Institutions, Federally Chartered

6036 Savings Institutions, Not Federally Chartered

6061 Credit Unions, Federally Chartered

6062 Credit Unions, Not Federally Chartered

6081 Branches And Agencies Of Foreign Banks

6082 Foreign Trade And International Banking Institutions
6091 Nondeposit Trust Facilities

6099 Functions Related To Depository Banking, nec
6111 Federal & Federally Sponsored Credit

6141 Personal Credit Institutions

6153 Short-Term Business Credit Institutions, Except Agricultural
6159 Misc. Business Credit Institutions

6162 Mortgage Bankers And Loan Correspondents

6163 Loan Brokers

6211 Security Brokers, Dealers, And Flotation Companies
6221 Commodity Contracts Brokers And Dealers

6231 Security And Commodity Exchanges

6282 Investment Advice

6289 Services Allied With The Exchange Of Securities Or Commodities, nec
6311 Life Insurance

6321 IAccident And Health Insurance

6324 Hospital And Medical Service Plans

6331 Fire, Marine, And Casualty Insurance

6351 Surety Insurance

6361 Title Insurance

6371 Pension, Health, And Welfare Funds

6399 Insurance Carriers, nec

6411 Insurance Agents, Brokers, And Service

6512 Operators Of Nonresidential Buildings
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SIC Code Description of SIC Code
6513 Operators Of Apartment Buildings
6514 Operators Of Dwellings Other Than Apartment Buildings
6515 Operators Of Residential Mobile Home Sites
6517 Lessors Of Railroad Property
6519 Lessors Of Real Property, nec
6531 Real Estate Agents And Managers
6541 Title Abstract Offices
6552 Land Subdividers And Developers, Except Cemeteries
6553 Cemetery Subdividers And Developers
6712 Offices Of Bank Holding Companies
6719 Offices Of Holding Companies, nec
6722 Management Investment Offices, Open-End
Unit Investment Trusts, Face-Amount Certificate Offices, And Closed-End Management
6726 Investment Offices
6732 Educational, Religious And Charitable Trusts
6733 Trusts, Except Educational, Religious, And Charitable
6792 Oil Royalty Traders
6794 Patent Owners And Lessors
6798 Real Estate Investment Trusts
6799 Investors, nec
7011 Hotels & Motels
7021 Rooming & Boarding Houses
7032 Sporting & Recreational Camps
7033 Recreational Vehicle Parks And Campsites
7041 Organization Hotels & Lodging Houses, On Membership Basis
7211 Power Laundries, Family & Commercial
7212 Garment Pressing & Agents For Laundries & Drycleaners
7213 Linen Supply
7215 Coin-Operated Laundries & Dry Cleaning
7216 Dry Cleaning Plants, Except Rug Cleaning
7217 Carpet & Upholstery Cleaning
7218 Industrial Launderers
7219 Laundry & Garment Services, nec
7221 Photographic Studios Portrait
7231 Beauty Shops
7241 Barber Shops
7251 Shoe Repair Shops & Shoeshine Parlors
7261 Funeral Service And Crematories
7291 [Tax Return Preparation Services
7299 Miscellaneous Personal Services, nec
7311 IAdvertising Agencies
7312 Outdoor Advertising Services
7313 Radio Television & Publisher's Advertising Representatives
7319 IAdvertising, nec
7322 IAdjustment And Collection Services
7323 Credit Reporting Services
7331 Direct Mail Advertising Services
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SIC Code Description of SIC Code

7334 Photocopying And Duplicating Services

7335 Commercial Photography

7336 Commercial Art & Graphic Design

7338 Secretarial & Court Reporting Services

7342 Disinfecting & Pest Control Services

7349 Building Cleaning & Maintenance Services, nec
7352 Medical Equipment Rental & Leasing

7353 Heavy Construction Equipment Rental & Leasing
7359 Equipment Rental & Leasing, nec

7361 Employment Agencies

7363 Help Supply Services

7371 Computer Programming Services

7372 Prepackaged Software

7373 Computer Integrated Systems Design

7374 Computer Processing & Data Preparation & Processing Services
7375 Information Retrieval Services

7376 Computer Facilities Management Services

7377 Computer Rental & Leasing

7378 Computer Maintenance And Repair

7379 Computer Related Services, nec

7381 Detective Guard & Armored Car Services

7382 Security Systems Services

7383 News Syndicates

7384 Photo Finishing Laboratories

7389 Business Services, nec

7513 Truck Rental And Leasing Without Drivers

7514 Passenger Car Rental

7515 Passenger Car Leasing

7519 Utility Trailer And Recreational Vehicle Rental
7521 IAutomobile Parking

7532 [Top Body & Upholstery Repair Shops & Paint Shops
7533 IAuto Exhaust System Repair Shops

7534 Tire Retreading And Repair Shops

7536 IAutomotive Glass Replacement Shops

7537 IAutomotive Transmission Repair Shops

7538 General Automotive Repair Shops

7539 IAutomotive Repair Shops, nec

7542 Carwashes

7549 IAutomotive Services, Except Repair & Carwashes
7622 Radio And Television Repair Shops

7623 Refrigeration & Air-Conditioning Repair

7629 Electrical And Electronic Repair Shops, nec
7631 \Watch Clock & Jewellery Repair

7641 Reupholstery And Furniture Repair

7692 \Welding Repair

7694 Armature Rewinding Shops

7699 Repair Shops And Related Services, nec
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SIC Code Description of SIC Code

7812 Motion Picture And Video Tape Production
7819 Services Allied To Motion Picture Production
7822 Motion Picture And Video Tape Distribution
7829 Services Allied To Motion Picture Distribution
7832 Motion Picture Theaters, Except Drive-In
7833 Drive-In Motion Picture Theaters

7841 \Video Tape Rental

7911 Dance Studios Schools & Halls

7922 [Theatrical Producers (Except Motion Picture) And Miscellaneous Theatrical Services
7929 Bands Orchestras Actors & Other Entertainers & Entertainment Groups
7933 Bowling Centers

7941 Professional Sports Clubs And Promoters
7948 Racing, Including Track Operation

7991 Physical Fitness Facilities

7992 Public Golf Courses

7993 Coin-Operated Amusement Devices

7996 Amusement Parks

7997 Membership Sports And Recreation Clubs
7999 Amusement And Recreation Services, nec
8011 Offices And Clinics Of Doctors Of Medicine
8021 Offices And Clinics Of Dentists

8031 Offices And Clinics Of Doctors Of Osteopathy
8041 Offices And Clinics Of Chiropractors

8042 Offices And Clinics Of Optometrists

8043 Offices And Clinics Of Podiatrists

8049 Offices And Clinics Of Health Practitioners, nec
8051 Skilled Nursing Care Facilities

8052 Intermediate Care Facilities

8059 Nursing And Personal Care Facilities, nec
8062 General Medical And Surgical Hospitals

8063 Psychiatric Hospitals

8069 Specialty Hospitals Except Psychiatric

8071 Medical Laboratories

8072 Dental Laboratories

8082 Home Health Care Services

8092 Kidney Dialysis Centers

8093 Specialty Outpatient Facilities, nec

8099 Health And Allied Services, nec

8111 Legal Services

8211 Elementary And Secondary Schools

8221 Colleges, Universities, & Professional Schools
8222 Junior Colleges And Technical Institutes

8231 Libraries

8243 Data Processing Schools

8244 Business And Secretarial Schools

8249 \Vocational Schools, nec

8299 Schools And Educational Services, nec
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SIC Code Description of SIC Code

8322 Individual And Family Social Services

8331 Job Training And Vocational Rehabilitation Services
8351 Child Day Care Services

8361 Residential Care

8399 Social Services, nec

8412 Museums And Art Galleries

8422 IArboreta And Botanical Or Zoological Gardens

8611 Business Associations

8621 Professional Membership Organizations

8631 Labor Unions & Similar Labor Organizations

8641 Civic, Social, And Fraternal Associations

8651 Political Organizations

8661 Religious Organizations

8699 Membership Organizations, nec

8711 Engineering Services

8712 Architectural Services

8713 Surveying Services

8721 IAccounting, Auditing, And Bookkeeping Services

8731 Commercial Physical & Biological Research

8732 Commercial Economic, Sociological & Educational Research
8733 Noncommercial Research Organizations

8734 Testing Laboratories

8741 Management Services

8742 Management Consulting

8743 Public Relations Services

8744 Facilities Support Management Services

8748 Business Consulting Services, nec

8811 Private Households

9900 Services, nec

9111 Executive Offices

9121 Legislative Bodies

9131 Executive And Legislative Offices Combined

9199 General Government, nec

9211 Courts

9221 Police Protection

9222 Legal Counsel And Prosecution

9223 Correctional Institutions

9224 Fire Protection

9229 Public Order And Safety, nec

9311 Public Finance, Taxation, And Monetary Policy

9411 IAdministration Of Educational Programs

9431 IAdministration Of Public Health Programs

9441 Administration Of Social, Human Resource And Income Maintenance Programs
9451 Administration Of Veterans' Affairs, Except Health And Insurance
9511 Air And Water Resource And Solid Waste Management
9512 Land, Mineral, Wildlife, And Forest Conservation

9531 IAdministration Of Housing Programs
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9532 IAdministration Of Urban Planning And Community And Rural Development
9611 IAdministration Of General Economic Programs

9621 Regulation And Administration Of Transportation Programs

9631 Regulation & Admin Of Communications, Electric, Gas & Other Utilities
9641 Regulation Of Agricultural Marketing And Commaodities

9651 Regulation, Licensing, And Inspection Of Miscellaneous Commercial Sectors
9661 Space Research And Technology

9711 National Security

9721 International Affairs

9999 Non-classifiable Establishments

0000 Unclassified record
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Appendix E: Border Crossings and Customs Offices

More information regarding border crossings can be obtained from the www.ccra-adrc.gc.ca
(Memorandum D-1-1-1, Locator Code: 233B) from Canada Customs and Revenue Agency (CCRA).

The following information is sourced directly from the CCRA website and provides definitions and
explanations of the data contained in the Border Crossings and Customs (bor) look up table:

Explanation of Columns

2. The detailed office information is presented in an eight-column table that follows a standardized pattern
with some exceptions.

Port No. (Column 1)

3. The number in the first column of the table indicates the office number or port number as specified in
the Accelerated Commercial Release Operations Support System (ACROSS). Offices that have a number
in the first column and nothing in the second column are independent offices, and they do not report
through any other office or location.

4. Locations that have a number in both the first and second column are subordinate offices that
generally process their transactions through another office. An Inland Alternate Service (IAS) site reports
to an independent office called a hub. Subordinate offices have their number in the first column and the
number and name of the office they report to in the second column.

Note: Transactions may be processed using either number, depending on local preferences.

5. Service sites such as sufferance warehouses and marinas usually do not have a distinct number.
They process all their transactions using an independent office number.

Reports to Office (Column 2)

6. This column presents the number and name of the independent office through which subordinate
offices or service sites process their transactions.

Customs Office (Column 3)

7. The third column contains the name, and where applicable, the address and telephone numbers of the
office or site. Customs offices and service sites include actual staffed customs offices, airports, vessel
clearance terminals, offices that are serviced by staff from another location, sufferance warehouses, and
CANPASS locations. Not all locations or facilities provide all services, and some facilities may be
restricted to certain types of traffic or classes of goods. Offices names followed by "IAS" indicate that they
have been designated as an area that is serviced through the Inland Alternate Service program.

Hierarchy of Offices and Sites

8. In general, each region is divided into an individual appendix and then sub-divided into districts within
that appendix. (Note: Southern Ontario has recently been reorganized as one region with three separate
divisions. For formatting purposes only, this document treats each division as if it were a separate region,
resulting in a separate appendix for Southern Ontario (Inland), Southern Ontario (Niagara/Fort Erie), and
Southern Ontario (Windsor/St. Clair)). Wherever possible, the primary or independent offices are listed in
numerical order with their subordinate offices and service sites listed immediately after them. As a result
of this, some subordinate offices may initially appear to be out of numerical order. However, they are
actually in their appropriate place under the primary or the hub through which they process their
transactions.
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9. Finally, a third level of sorting has been applied to the information provided in column 3. Having been
first grouped by the independent office number and then the subordinate office numbers in columns 1
and 2, the various offices and sites are prioritized according to the type of function or service they provide.

10. The general categories are, in descending order:
(a) independent office and subordinate offices;

(b) airports;

(c) marine facilities;

(d) rail stations and depots;

(e) warehouses; and

(f) CANPASS service sites.

Hours of Service (Columns 4 and 5)

11. The hours of service indicate the hours that have been officially designated as the times when the
customs office is normally open for business. Locations that are listed as being open 24 hours per day,

7 days a week may not provide all services during the entire 24-hour period. For example, some offices
may provide full release and accounting services during the day shift, Monday to Friday, but may not have
full accounting services available during the evenings or weekends. Clients are encouraged to verify
hours of operation with their local offices. Requests for new or expanded services, or services outside the
normal business hours, may be subject to cost recovery or special service charges.

12. Further information about the authorized hours of service at customs offices may be obtained by
referring to Memorandum D1-2-1, Special Services.

Services (Column 6)

13. The symbols shown in column 6 indicate the specific services or activities available at the customs
office or service site. The definitions are not necessarily all-inclusive and should be used as a guide only.

HWY - Land and Inland Border Office - authorized port of entry at which passenger, general public,
or commercial highway traffic is permitted to report. Land borders include both CANADA/U.S. border
crossing points and inland border points.

EDI - Electronic Data Interchange - the transmission, transfer, interchange, or electronic release of
accounting data.

IAS - Inland Alternate Service - the provision of release services to inland locations from a hub.
COMMERCIAL - Designhated Commercial Office - offices that provide commercial service free from
the imposition of any special service charges on a 7 day/24 hour basis.

IMM - Immigration - an immigration officer is on site.

NTO - Non-Terminal Office - office is not equipped with a computer communication system.

POST - International Mail Centre - office at which the processing of international mail or the control
of outstanding postal accounts occurs.

AERO-INTL - International Airport - authorized customs airport of entry and exit for clearance of all
classes of air traffic (Airport of Entry Designator Code AOE-A - see Memorandum D2-5-1, Charter
Access to Airports).

AERO-REG - Regional Airport - authorized customs airport of entry and exit for clearance of
commercial air traffic carrying freight or a passenger load not exceeding the capacity limits specified
(Airport of Entry Designator Code AOE-R or AOE-RA - see Memorandum D2-5-1).

AERO-GEN - General Aviation Airport - authorized customs airport of entry and exit for general
aviation air traffic, i.e., privately operated or small charter aircraft carrying no more than

15 passengers and their baggage (Airport of Entry Designator Code AOE-X or AOE-XA - see
Memorandum D2-5-1).

SeaPl - Sea Plane Landing Site - authorized point of entry for sea planes.

C-Ves - Commercial Vessel Clearing Station - locations at which commercial vessels are permitted
to report.
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P-Ves - Private or Non-Commercial Vessel Reporting Station - locations at which non-commercial
vessels (pleasure crafts) are permitted to report.

FERRY - Ferry Terminal - terminal where passengers and vehicles embark or disembark from a
ferry.

CSO - Cruise Ship Operations - authorized debarkation site for cruise ship passengers and crew.
RAIL - Railway Depot - first point in Canada at which a passenger or freight train stops and
discharges passengers or goods.

SWH - Warehouse - highway sufferance warehouses or special bonded warehouses for perishable
goods.

Shop - Duty-Free Shop - a duty-free shop is located at the customs location. More specific duty-free
shop details can be obtained from Memorandum D4-3-2, Duty Free Shop - Licensing.

ACEEO - locations at which acting Revenue Canada enforcement officers have been authorized.
CPO - Only the CANPASS programs are serviced at this location

CPA - CANPASS - Private and Corporate Aircraft

CPB - CANPASS - Private Boat

CPL - CANPASS - Voyageur

Note: All references to CANPASS programs, services, or sites refer to a CANPASS pilot project that was
being tested at the time this document was released.

Airport or Vessel Code (Column 7)

14. This column identifies the airport designator code, the passenger capacity limits per flight for
inspection services purposes, and the station responsible for flight plans. Further information regarding
services provided at airports can be obtained from Memorandum D3-2-1, International Air Traffic, and
Memorandum D2-5-1. Vessel registration office numbers are also included in this section.

Opposite U.S. Office (Column 8)

15. The U.S. customs office is opposite the Canadian customs office.
ADDITIONAL INFORMATION

16. All requests for revisions should be submitted to the following address:

Manager of Facilities and Services

Operational Policy and Coordination Directorate
Customs and Trade Administration Branch
Revenue Canada

15th floor

Sir Richard Scott Building

191 Laurier Avenue West

Ottawa ON K1A OL5
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Appendix F: Canadian Payments Association Classification

The Canadian Payments Association (CPA) developed a classification system, which divides the
institutions belonging to the payments associations into three groups:

1. Banks
2. Credit Unions and Caisses Populaires
3. Trust Companies, Loan Companies, and Other Deposit-Taking Institutions.

In conjunction with this classification system, the Financial Institution layer includes a field called
FIN_TYPE. The following is a listing of institution names, by their corresponding classification type, as
they appear in the FIN_TYPE field:

Banks
AMEX Bank of Canada Habib Canadian Bank
AMICUS Bank HSBC Bank Canada
Bank of America Canada ING Bank of Canada
Bank of Canada International Commercial Bank of Cathay
Bank of China Intesabci Canada
Bank of East Asia (Canada) JP Morgan Bank Canada
Bank of Montreal JP Morgan Chase Bank
Bank of Nova Scotia Korea Exchange Bank of Canada
Bank of Tokyo Mitsubishi (Canada) Manulife Bank of Canada
Bank One NA MBNA Canada Bank
Banque Laurentienne du Canada Mellon Bank Canada
Banque Nationale du Canada Mizuho Bank (Canada)
BNP Paribas (Canada) National Bank of Greece (Canada)
Canadian Imperial Bank of Commerce Paribas Bank of Canada
Canadian Western Bank Royal Bank of Canada
Capital One Bank (Canada Branch) Sakura Bank (Canada)
Cho Hung Bank of Canada Societe Generale (Canada)
Citibank Canada Sottomayor Bank Canada
Citibank, NA State Bank of India (Canada)
Citizens Bank of Canada Sumitoma Mitsui Banking Corporation of
Comerica Bank Canada
Credit Lyonnais Canada Tokai Bank Canada
Credit Suisse First Boston Canada Toronto-Dominion Bank, (The)
CS Alterna Bank UBS Bank Canada
CTC Bank of Canada UFJ Bank Canada
Deutsche Bank (Canada) United Overseas Bank (Canada)
Dresdner Bank Canada
Credit Unions and Caisses Populaires

Airline (Malton Credit Union)

Alltrans Credit Union

L’Alliance des caisses populaires de I'Ontario

Brunswick Credit Union Federation Ltd.
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CBC (Toronto) Credit Union Limited
Civil Service Co-op Credit Society

Co-operative Credit Society of Manitoba Limited
Communication Technologies CR UN Ltd

Confederation des caisses populaires et d’economie Desjardins du Quebec

Credit Union Central Alberta Ltd

Credit Union Central of British Columbia

Credit Union Central of Nova Scotia
Credit Union Central of Ontario Ltd

Credit Union Central of Saskatchewan

Duca Community Credit Union Ltd
Dundalk District Credit Union Ltd

Federation des Caisses Populaires Acadiennes Limitee, La
Federation des Caisses Populaires de I'Ontario Inc, La
Federation des Caisses Populaires du Manitoba Inc, La

The Fire Department Employees Credit Union Ltd
Goderich Community Credit Union Ltd

Latvian Credit Union Limited

North York Community Credit Union Limited
Ontario Civil Services Credit Union Limited
Polysar Lambton Credit Union Limited

St Stanislaus-St Casimir’s Polish Parishes Credit Union Limited

Trust Companies, Loan Companies, and Other Deposit-Taking Institutions

AGF Trust Company
Alberta Treasury Branches
B2B Trust

B.C. Community Financial Services Corporation

Canada Trust Company, The
Citizens Trust Company

Clarica Trust Company, The

Effort Trust Company, The
Evangeline Savings & Mortgage Co
Family Trust Corporation

Fuji Bank Canada

Granville Savings & Mortgage Corp
Home Savings and Loan Corporation
Household Trust Company
International Trust Company
Investors Group Trust Co. Ltd.
MRS Trust Company

Mennonite Trust Ltd
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Municipal Savings & Loan Corporation, The

Municipal Trust Company, The
National Trust Company

Peace Hills Trust Company
Promutuel Capital Trust Company Inc
Province of Ontario Savings Office
Royal Trust Company, The

Royal Trust Corporation of Canada
Settlers Savings and Mortgage Corp
Sherbrooke Trust, Company
Societe D’Epargne St Bernard, La
Sun Life Financial Trust Inc

TD Trust Company

Trimark Trust

Trust General du Canada

Trust General Inc

Trust La Laurentienne
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English Abbreviations and Definitions

AB
ACC
ACC

ACIIS

ADMIN
AE DIST
AIR
AMF
AMT
A&P
ARU

ATI
ATTF
AVE

BC

BLDG
BLVD
BNPP

BP DIST
BR

BSG DIST
BUR

CAL
CAS
C-B DIST
CBS
CCAPSD

CcCB
CCIS

CCRA

CCs
CDIU
CDN
C&E
CEF
CE&T
CFC
CFDU
CFSEU

CHARLT'N
CiB

CIC

CID

Clu

CIR
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A

ALBERTA

ACCIDENT

ADMINISTRATION
COMMUNICATIONS CENTRE
AUTOMATED CRIMINAL
INTELLIGENCE

INFORMATION SYSTEM
ADMINISTRATION/ADMINISTRATIVE
AVALON EAST DISTRICT
AIRPORT

AIRPORT MAIL FACILITY

AREA MANAGEMENT TEAM
ADMINISTRATION & PERSONNEL
ALTERNATE RESPONSE UNIT
ACCESS TO INFORMATION
AUTO THEFT TASK FORCE
AVENUE

B

BRITISH COLUMBIA

BUILDING

BOULEVARD
BERESFORD/NIGADOO/PETIT-
ROCHER/POINTE-VERTE
BURIN PENINSULA DISTRICT
BRANCH

BAY ST GEORGE DISTRICT
BUREAU

C

CALGARY

CRIMINAL ANALYSIS SECTION
CLARENVILLE-BONAVISTA DISTRICT
CUSTOMS BORDER SERVICES
COMMUNITY, CONTRACT &
ABORIGINAL POLICING SERVICES
COMMERCIAL CRIME BRANCH
CALGARY CRIMINAL INTELLIGENCE
SECTION

CANADA CUSTOMS & REVENUE
AGENCY

COMMERCIAL CRIME SECTION
CENTRAL DRUG INFORMATION UNIT
CANADIAN

CUSTOMS & EXCISE

CONTAINER EXAMINATION FACILITY
CUSTOMS, EXCISE & TAXATION
CANADIAN FIREARMS CENTRE
COMBINED FORCES DRUG UNIT
COMBINED FORCES SPECIAL
ENFORCEMENT UNIT
CHARLOTTETOWN

CRIMINAL INVESTIGATION BRANCH
CITIZEN & IMMIGRATION CANADA
CRIMINAL INTELLIGENCE
DIRECTORATE

CALGARY INTEGRATED
INTELLIGENCE UNIT

CIRCLE

CIS

CISA

CISBC

CISC

CISM

CISN

CISNB

CISNS

CISO

CISS

CcOB
COMCENTRE
COMM

COMP

CON

CONST
CO-ORD
CORRECT
CORRES
COoSs

CPC
CPIC
CPO
CPR
CPSIC
CR
CRS
CSAB
CSBC

CsC
CsIS

CSMB

CSNB

CSON
CSSK
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CRIME INDEX SECTION/CRIMINAL
INVESTIGATION SECTION
CRIMINAL INTELLIGENCE SERVICE
ALBERTA

CRIMINAL INTELLIGENCE SERVICE
BRITISH COLUMBIA

CRIMINAL INTELLIGENCE SERVICE
CANADA

CRIMINAL INTELLIGENCE SERVICE
MANITOBA

CRIMINAL INTELLIGENCE SERVICE
NEWFOUNDLAND

CRIMINAL INTELLIGENCE SERVICE
NEW BRUNSWICK

CRIMINAL INTELLIGENCE SERVICE
NOVA SCOTIA

CRIMINAL INTELLIGENCE SERVICE
ONTARIO

CRIMINAL INTELLIGENCE SERVICE
SASKATCHEWAN

CRIMINAL INTELLIGENCE UNIT
CIVIL/CIVILIAN

CIVIL LITIGATION

CLASSIFICATION

COORDINATED LAW ENFORCEMENT
UNIT

CIVILIAN MEMBER

CRIMINAL NAME INDEX
COMMANDING OFFICER

COUNTY

CRIMINAL OPERATIONS BRANCH
COMMUNICATIONS CENTRE
COMMUNICATIONS/COMMUNITY
COMPARTMENT

CONTRACTS

CONSTABULARY
COORDINATOR/COORDINATION
CORRECTIONAL
CORRESPONDENCE

CRIMINAL ORGANIZATION
/OPERATIONS SECTION
CANADIAN POLICE COLLEGE/
CASE PROCESSING CENTRE
CANADIAN POLICE INFORMATION
CENTRE

CASE PRESENTATION OFFICER
CANADIAN PACIFIC RAILWAY
CANADIAN POLICE SERVICES
INFORMATION CENTRE
CRESCENT

CRIMINAL RECORDS SYNOPSIS
CORRECTIONAL SERVICE ALBERTA
CORRECTIONAL SERVICE BRITISH
COLUMBIA

CORRECTIONAL SERVICE CANADA
CANADIAN SECURITY
INTELLIGENCE SERVICE
CORRECTIONAL SERVICE
MANITOBA

CORRECTIONAL SERVICE NEW
BRUNSWICK

CORRECTIONAL SERVICE ONTARIO
CORRECTIONAL SERVICE
SASKATCHEWAN
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CST
CTR
CTY

D5
DCAS

DCAU

DCIAS

DEB
DEPT
DES
DET
DEOC

DEU
DHQ
DIFO

DIR
DIST
DIV

DL DIST
DND

DOAC
D&R
DSC

DSRR

ECD

ECON
EDT'N
EDPS

EEOC

E&l
EllU

ENF/ENFORCE
ERM

ERT
ESO
EST
ESU
EU
EXEC

FAC
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CONSTABLE
CENTRE
CITY

D

DISTRICT

DIVISION CRIMINAL ANALYSIS
SECTION

DIVISION CRIMINAL ANALYTICAL
UNIT

DIVISIONAL CRIMINAL INFORMATION
ANALYTICAL SECTION/DIVISION
CRIME INTELLIGENCE ANALYTICAL
SERVICE

DRUG ENFORCEMENT BRANCH
DEPARTMENT

DRUG ENFORCEMENT SECTION
DETACHMENT

DIVISION EMERGENCY OPS
COMCENTRE

DRUG ENFORCEMENT UNIT
DISTRICT HEADQUARTERS
DRUG INTELLIGENCE & FIELD
OPERATIONS
DIRECTOR/DIRECTORATE
DISTRICT

DIVISION

DEER LAKE DISTRICT
DEPARTMENT OF NATIONAL
DEFENCE

DANGEROUS OFFENDERS
APPLICATIONS CENTRE
DETENTION & REMOVALS
DRIVE

DIRECTORATE OF SECURITY
CLEARANCES

DIVISIONAL STAFF RELATIONS
REPRESENTATIVE

E

EAST

ECONOMIC CRIME DIRECTORATE
ECONOMIC

EDMONTON

EXECUTIVE DIPLOMATIC
PROTECTION
SECTION/ELECTRONIC DATA
PROCESSING SECTION

EAST EUROPEAN ORGANIZED
CRIME

ENFORCEMENT & INVESTIGATIONS
EDMONTON INTEGRATED
INTELLIGENCE UNIT
ENFORCEMENT

ENVIRONMENT & RESOURCE
MANAGEMENT

EMERGENCY RESPONSE TEAM
ENFORCEMENT SERVICES OFFICER
ESTABLISHMENT

ENFORCEMENT SUPPORT UNIT
ENFORCEMENT UNIT

EXECUTIVE

F

FIREARMS ACQUISITION
CERTIFICATE

FBI

FED
FES
FIC

FINGERPRT
FINTRAC

FIS

FIU
FLR
FLSD

FNCPS
FOSS

FOT

FPS
FREDT'N
FRY

FSD
F&SD
FSSB
BRANCH

GD
GF-W DIST
GHQ

GIS

GST

GTEC

HTS
HV-GOOSE BAY
HWY

IAP
I/C, IC
1&C
ICBC
ICES
ICPB
ID
IDENT
IFB
IFSB
IIEU

s
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FEDERAL BUREAU OF
INVESTIGATION

FEDERAL

FEDERAL ENFORCEMENT SECTION
FINANCIAL INSTITUTIONS
COMMISSION

FINGERPRINT

FINANCIAL TRANSACTIONS AND
REPORTS ANALYSIS CENTRE OF
CANADA

FORENSIC IDENTIFICATION
SECTION

FEDERAL INVESTIGATION UNIT
FLOOR

FORENSIC LAB SERVICES
DIRECTORATE

FIRST NATIONS COMMUNITY
POLICE SERVICE

FIELD OPERATIONS SUPPORT
SYSTEM

FEDERAL OPERATIONS TEAM
FINGERPRINT SECTION
FREDERICTON

FREEWAY

FEDERAL SERVICES DIRECTORATE
FINANCE & SUPPLY DIRECTORATE
FINANCIAL SERVICES & SUPPLY

G

GENERAL DELIVERY

GRAND FALLS-WINDSOR DISTRICT
GENERAL HEADQUARTERS
GENERAL INVESTIGATION SECTION
GOODS AND SERVICES TAX
GREATER TORONTO
ENFORCEMENT SECTION

H

HALIFAX

HIGHWAY PATROL
HEADQUARTERS

HALIFAX REGIONAL POLICE
HEIGHTS

HAPPY VALLEY-GOOSE BAY
HIGHWAY

INTERNATIONAL AIRPORT
INFORMATICS BRANCH

IN CHARGE

INTELLIGENCE & CONTRABAND
INSURANCE CORPORATION OF
BRITISH COLUMBIA
INTERNATIONAL CUSTOMS
ENFORCEMENT SYSTEM
INSURANCE CRIME PREVENTION
BUREAU

INFORMATICS DIRECTORATE
IDENTIFICATION

IMMIGRATION & FEDERAL BRANCH
INFORMATICS FIELD SUPPORT
BRANCH

INTEGRATED INTELLIGENCE
ENFORCEMENT UNIT
IMMIGRATION INVESTIGATIVE
SERVICE
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1&ISD

131S

ILB
IL&POD

IMS

IMU
INFO
INSET

INST

INTELL
INTERN
INTERPOL
INT'L
INVEST
IPOC
IP/I&P
IPPC

IPS

IPSO

ISTB

U
IWRC

JCT
JFO
JPST
JSFU

L DIST
LAB

LB
LBPIAP

LIT
LMD

MB
MBC
MCU
METRO
MGR
MGT
MIIU

M.LEG

MPIC

MRU

MTD
MTN

www.dmtispatial.com

INFORMATION & IDENTIFICATION
SERVICES DIRECTORATE
INTEGRATED JUSTICE
INFORMATION SYSTEM
INTERNATIONAL LIAISON BRANCH
INTERNATIONAL LIAISON &
PROTECTIVE

OPERATIONS DIRECTORATE
INFORMATION MANAGEMENT
SECTION

INFORMATION MANAGEMENT UNIT
INFORMATION/INFORMATICS
INTEGRATED NATIONAL SECURITY
ENFORCEMENT TEAM
INSTITUTES/ INSTITUTION /
INSTITUTIONAL

INTELLIGENCE

INTERNAL

INTERNATIONAL POLICE
INTERNATIONAL
INVESTIGATION/INVESTIGATIVE
INTEGRATED PROCEEDS OF CRIME
IMMIGRATION & PASSPORT
INTEGRATED POLICE PLANNING
COMMITTEE

IMMIGRATION & PASSPORT
SECTION

INSTITUTIONAL PREVENTIVE
SECURITY OFFICER

INFORMATION SYSTEM &
TECHNOLOGY BRANCH
INVESTIGATION UNIT
IMMIGRATION WARRANT RESPONSE
CENTRE

J

JUNCTION

JOINT FORCES OPERATIONS
JOINT POLICE SECURITY TEAM
JOINT SECURITY FRAUD UNIT

L

LABRADOR DISTRICT
LABORATORY

LESTER B.

LESTER B. PEARSON
INTERNATIONAL AIRPORT
LITIGATION

LOWER MAINLAND DISTRICT

M

MANITOBA

MIGRATORY BIRD CONTROL
MAJOR CRIMES UNIT
METROPOLITAN

MANAGER

MANAGEMENT

METRO INTEGRATED INTELLIGENCE
UNIT

MAIN LEGISLATIVE

MAIN OFFICE

MANITOBA PUBLIC INSURANCE
CORPORATION

MOBILE RESPONSE UNIT
MOUNT

MOUNTED

MOUNTAIN

MTRL
MUN
MVB

NHQ
NICB

NLETS

NP DIST
NS
NSI

NSIS

NSIU

ocC
occC

OCs
oic,ol/ic
oIS

ON
oP
OPF
OPP
OPS

OPS.OFF.

ORI:
0Sss
oTT

P.A.B.
PA&ID

PB

PCA
PCI

PD
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MONTREAL
MUNICIPAL
MOTOR VEHICLES BRANCH

N

NORTH

NATIONAL

NEW BRUNSWICK

NATIONAL CRIME INTELLIGENCE
BRANCH

NATIONAL CRIME INFORMATION
CENTER

NATIONAL CRIME INTELLIGENCE
SECTION

NON-COMMISSIONED MEMBER
NON-COMMISSIONED OFFICER
NORTH EAST

NORTH EAST NOVA
NEWFOUNDLAND

NATIONAL HEADQUARTERS
NATIONAL INSURANCE CRIME
BUREAU

NATIONAL LAW ENFORCEMENT
TELECOMMUNICATIONS SYSTEM
NORTHERN PENINSULA DISTRICT
NOVA SCOTIA

NATIONAL SECURITY INTELLIGENCE
SERVICE

NATIONAL SECURITY INTELLIGENCE
SERVICE

NATIONAL SECURITY
INVESTIGATIONS UNIT
NETWORK SERVICES SECTION
NORTH WEST

NORTHWEST TERRITORIES
NUNAVUT

o

OFFICER COMMANDING
OPERATIONAL COMMUNICATIONS
CENTRE

ORGANIZED CRIME SECTION
OFFICER IN CHARGE
OPERATIONAL INFORMATION
SYSTEMS

ONTARIO

OPERATIONAL

ONTARIO POLICE FORCES
ONTARIO PROVINCIAL POLICE
OPERATIONS

OFFSHORE SURV.

OPERATIONS OFFICER OFFSHORE
SURVEILLANCE

ORIGINATOR NUMBER
OPERATIONAL SUPPORT SECTION
OTTAWA

=]

PORT-AUX-BASQUES

PUBLIC AFFAIRS & INFORMATION
DIRECTORATE

PRIVACY BRANCH

POSTAL CODE

POLICE CAR ACCIDENTS

PUBLIC COMPLAINTS
INVESTIGATIONS

POLICE DEPARTMENT
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PDRC

PDS

P-W DIST

QC

RCMP

RD
REC
RECNST
REG
REGISTR
REL

RHQ
RIIU

RM

RMS
RPC
RPO
RPU
RR

RTE

SAS
SCQ
scs
scu

S/ID
S/DET

SEC
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POST DETERMINATION REFUGEE
CLASS

POLICE DOG SERVICES

PRINCE EDWARD ISLAND
PENITENTIARY

PERSONNEL

PARKING ENFORCEMENT UNIT
POLICE FORCE

POLICE INFORMATION RETRIEVAL
SYSTEM

PARK

PLACE

PLAIN LANGUAGE IDENTIFIER
POST OFFICE

PROCEEDS OF CRIME

PORT OF ENTRY

POLICING
PORNOGRAPHY/PORNOGRAPHIC
PROTECTIVE POLICING
DIRECTORATE

PROBATION
PROTECTION/PROTECTIVE
PROVINCIAL

POLICE SERVICE(S)

POLICE SUPPORT PROGRAMS
PERSONNEL SECURITY UNIT
PRIVATE
PLACENTIA-WHITBOURNE DISTRICT

Q
QUEBEC (CITY/PROVINCE)
R

ROYAL CANADIAN MOUNTED
POLICE

ROAD

RECORDS

RECONSTRUCTION
REGION/REGIONAL
REGISTRATION/REGISTRY
RELATIONS

REGIONAL HEADQUARTERS
REGINA INTELLIGENCE
INTEGRATED UNIT

ROOM/RURAL MUNICIPALITY
RECORDS MANAGEMENT SECTION
REGIONAL PSYCHIATRIC CENTRE
POSTAL OUTLET

REFUGEE PROCESSING UNIT
RURAL ROUTE

ROUTE

SOUTH

SEXUAL ASSAULT SECTION
SECURITY & QUALITY CONTROL
SERIOUS CRIME SECTION
SERIOUS CRIME UNIT/SECURITY
CLEARANCE UNIT

SUB-DIVISION
SUB-DETACHMENT

SOUTH EAST

SECTION

SECUR
SERV
SEU
SID
SIS
SIu
SK
S/o
SP'L
sQcC
SQUAD
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SECURITY

SERVICE(S)

SPECIAL ENFORCEMENT UNIT
STATE IDENTIFICATION
SPECIAL INVESTIGATION SECTION
SPECIAL INVESTIGATION UNIT
SASKATCHEWAN

SUB-OFFICE

SPECIAL

SECURITY & QUALITY CONTROL
SQUADRON

SR. RES OFFICER SENIOR REGIONAL ENFORCEMENT

SS

ST
ST/STE
STN
SUB-REG
SW

SYS

TA
TC DIST
T&D
TECH
TELECOM
TEMP

TF
TLBPIA

TOD

TOR
TOSS

TPOF

TSO
TWP

VANC
VCAS
VICLAS

ViU
VIN

VIP
VS

WARR
WE&EI

WL&AP
WPG

YT
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SERVICES OFFICER
SECURITY SERVICE
STREET

SAINT(E)

STATION
SUB-REGISTRY
SOUTH WEST
SYSTEM(S)

T

TEMPORARY ABSENCES
TRINITY CONCEPTION DISTRICT
TRAINING & DEVELOPMENT
TECHNICAL
TELECOMMUNICATIONS
TEMPORARY

TASK FORCE

TORONTO LESTER B. PEARSON
INTERNATIONAL AIRPORT
TECHNICAL OPERATIONS
DIRECTORATE

TORONTO

TECHNICAL OPERATIONS SUPPORT
SYSTEM

TECHNICAL AND PROTECTIVE
OPERATIONS FACILITY
TAXATION SERVICE OFFICE
TOWNSHIP

\%

VANCOUVER

VIOLENT CRIME ANALYSIS SECTION
VIOLENT CRIME LINKAGE ANALYSIS
SYSTEM

VANCOUVER INTEGRATED
INTELLIGENCE UNIT

VEHICLE IDENTIFICATION NUMBER
VERY IMPORTANT PERSONS
VICTIMS' SERVICES

W

WEST
WARRANT(S)

WILDLIFE ENFORCEMENT AND
ENVIRONMENT INTELLIGENCE
WATER, LAND & AIR PROTECTION
WINNIPEG

Y

YUKON TERRITORY



AB
ACT
AD&I
ADM
ADRC
APPL

AV

BC
BCS

BDNC
BOUL
BRQCO
BST

BUR

CAAF

CAF
CANT
CDT S.-DIv.

CE
CH
CIC

CIPC
CISCP

Clv
CJs

(6{0)
COMM

CONTR
CONURB
COORD
cp

CQ

CR
CRIM
CRPQ

CRU
CSSP

CTE
CTR

D-5
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French Abréviations et Equivalents

A

ALBERTA

AGENT DE LIAISON

ACTIVITE

ACCISE, DOUANES ET IMPOT
ADMINISTRATION/ADMINISTRATIVE
AGENCE DES DOUANES & DU
REVENU DU CANADA
APPLICATION

ABSENCES TEMPORARIES
AVENUE

B

COLOMBIE-BRITANNIQUE

BUREAU CONTROLE DES SOURCES
BUREAU DE LIAISON

BANQUE NATIONAL DES DONNEES
CRIMINELLES

BOULEVARD

BUREAU REGIONAL

BUREAU DE RECHERCHES DU
QUEBEC SUR LE CRIME ORGANIZE
BUREAU SERVIENCE DE
TERRITOIRE

BUREAU

C

CERTIFICATE D'ACQUISITION
D'ARME A FEU
CONTROLEUR DES ARMES A FEU
CANTON

COMMANDANT SOUS-
DIVISIONNAIRE
CONTROLE DES EFFETS

CHEMIN

CITOYENNETE ET IMMIGRATION
CANADA

CENTRE D'INFORMATION DE LA
POLICE CANADIENNE

CENTRE D'INFORMATION DES
SERVICES CANADIENS DE POLICE
CIVIL(E)

CASIERS JUDICIARIES
SYNOPTIQUES
CENTRED'OPERATION
COMMUNAUTE/
COMMUNICATIONS/COMMUTATION
CONTROLE

CONURBATION
COORDINATION/COORDONNATEUR
CASIER POSTAL

CONTROLE QUALITE
CRIMINEL(LES)

CRIMINEL(LES)
CENTRE DE RENSEIGNEMENTS
POLICIERS DU QUEBEC

CENTRE RENVOIS UNIFIE

CENTRE SERVICE EN SECURITE
PUBLIQUE

COMTE

CENTER

D

DISTRICT 5

DA

DEC
DEV

DIR
DIST

DIV
DSTEC

ES

ESS
ETAB

FED
FIN
FIN

GClI

GEN
GOUVERN
GPC

GQG
GRC

HUM

ICJ
ID
IND:
INFO
INT'L

IRC

JuD
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COUANES ET ACCISE

DELITS COMMERCIAUX
DIVISION DES ENQUETES
DEVELOPPEMENT

DIRECTION GENERALE
DIRECTION

DISTRICT

DIVISION(NAIRE)

DIVISION SOUTIEN TECHNIQUE
ENQUETES CRIMINELLS

E

EST

ENQUETES CRIMINEL (LES)
ESCOUADE CRIMINAL MAJEURS
ENQUETES CRIMINEL(LES)
/SUPPORT TECHNIQUE
ESCOUADE CRIME ORGANISE
ENQUETES FRONTALIERES
ENQUETES GENERALES
ENQUETES

ESCOUDE REGIONALE ALCOOL ET
MORALITE

ESCOUADE REGIONALE DES
MOEURS

ENQUETES SPECIALES
/SPECIALISEES

ENQUETES SPECIAL SECURITE
ETABLISSEMENT

F

FEDERAL(ES)
FINANCIER/FINANCIERES
FICHIER JUDICIAIRE NOMINATIF

G

GROUPE DE CONTROLE ET DE
L'INFORMATION

GENERAL (E)

GOUVERNEMENT
GROUPE DES PRODUITS DE LA
CRIMINALITE

GRAND QUARTIER GENERAL
GENDARMERIE ROYALE DU CANADA

H
HUMAINES
|

INFORMATION DES CASIERS
JUDICIAIRES

IDENTITE

INDICATIF
INFORMATION/INFORMATIQUE/
INFORMATISES
INTERNATIONALE

IMMIGRATION ET PASSEPORT
INTERVENTION REGION CENTRE

J

JUDICIAIRE
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LOC

M/MON
MAT

MDN

MGR
MIG
MLLL

MRC
MSI

MT
MTRL
MUN

OFF.
OFF.DIV.
OFF. RESP.
OIX

ON
OP/OPER

QC
QG
QGDIQG
DISTRICT
QUIQUAL

RACJ
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LOCAL
M

MONITEUR

MATERIEL

MANITOBA

MINISTERE DE LA DEFENSE
NATIONALE

MONSEIGNEUR

MIGRATION

MONTREAL, LAVAL, LAURENTIDES &
LANAUDIER

MUNICIPALITE REGIONALE DE
COMPTE

MONITEUR SYSTEMES
INFORMATISES

MONT

MONTREAL

MUNICIPAL

N

NORD
NATIONAL(E)
NOUVEAU-BRUNSWICK
NORD-EST

TERRE-NEUVE

NUMEROS D'IDENTIFICATION DE
VEHICULES

NORANDA

NOUVEAU

NOUVELLE-ECOSSE
TERRITOIRES DU NORD-OUEST
NUNAVUT

o

OUEST

OFFICIER

OFFICIER DIVISIONNAIRE
OFFICIER RESPONSIBLE
OISEAUX

ONTARIO
OPERATIONNEL (LES)

P

PRODUITS DE LA CRIMINALITE
POSTE DE QUARTIER
ILE-DU-PRINCE EDOUARD
POLICERES

PATROUILLE ROUTIERE
PROMENADE

PROTECTION

Q

QUEBEC (VILLE OU PROVINCE)
QUARTIER GENERAL
QUARTIER GENERAL DE DISTRICT

QUALITE

R

REGIE ALCOOL COURSES ET JEUX

RC

REG

REL
RENS
REPRESS
RESP
RESS
ROUT

RS

RSO

RTE

SAAQ
SARC

SAU
scc
sScQ

SCRS

SD
S-D
SDAIC

SDC

SDEC

S-DIC

S.-DIV.
S.-DON/
S.-DIRECTION
SDRC

SEC
SECT
SEEA

SEF

SEG
SELF

SEM

SENS
SERV
SESN

SESS

SFD
DOUANES
SKFJ

SLAD

SM

S.OFF. RESP
SP

SPC
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RENSEIGNEMENTS CRIMINALS
REGION/REGIONAL(E)
RELATIONS
RENSEIGNEMENT(S)
REPRESSION

RESPONSABLE

RESSOURCES
ROUTIER/ROUTIERE
RENSEIGNEMENTS SECURITE
RAPPORTS STATISTIQUES SUR LES
OPERATIONS

ROUTE

SUD

SOCIETE ASSURANCE AUTOMOBILE
QUEBEC

SYSTEME AUTOMATISE DES
RENSEIGNEMENTS CRIMINELS
SERVICES AUX USAGERS
SERVICE CORRECTIONNEL CANADA
SERVICE CORRECTIONAL DU
QUEBEC

SERVICE CANADIEN DU
RENSEIGNEMENT+DE SECURITE
SERVICE DIVISIONNAIRE
SOUS-DIVISION

SERVICE DIVISIONNAIRE DES
ANALYSES DES INFORMATIONS
CRIMINELLES

SECTION DES DELITS
COMMERCIAUX

SERVICE DIVISIONNAIRE DES
ENQUETES

CRIMINELLES

SOUS-DIRECTION DES
INFRACTIONS

COMMERCIALES

SOUS-DIVISION

SOUS DIRECTION
SERVICE DIVISIONNAIRE
RENSEIGNEMENTS CRIMINELS
SECURITE

SECTION

SECTION ENQUETES
ECONOMIQUES

ANTIDROGUE

SECTION ENQUETES
FRONTALIERES

SECTION ENQUETES GENERALES
SECTION ENQUETES LOIS
FEDERALES

SEMAINE

SENSIBILISATION

SERVICE(S)

SECTION ENQUETES RELATIVES A
LA SECURITE NATIONALE
SERVICE ENQUETES SPECIALE
SECURITE

SERVICE FRONTALIER DES

SECTION DU FICHIER/JUDICIAIRE
SECTION LUTTE ANTIDROGUE
SURETE MUNICIPAL DU QUEBEC
SOUS-OFFICIER RESPONSABLE
SERVICE DE POLICE

SECTION POLICE CRIMINELLE
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SPCUM

SPEC
SPPCAD

SPVM

SQ
SRAC

SRC
SRCMD
SRCQ

SRR
SR/TR

SS
SSID

SSR

ST/ISTE
STO

SuccC
SUPP
SUR

SURV
SYST
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SERVICE DE POLICE DE LA
COMMUNAUTE

URBAINE DE MONTREAL
SPECIAL(E)

SECTION DE LA PROTECTION DES
PERSONNALITES CANADIEN ET
AGENTS DIPLOMATIQUES
SERVICE DE POLICE DE LA VILLE DE
MONTREAL

SURETE DU QUEBEC

SECTION RENSEIGNEMENTS ET
ANALYSES CRIMINALS
SECTION/SERVICE DES
RENSEIGNEMENTS CRIMINELLES
SECTION DES RENSEIGNEMENTS
CRIMINELS MORALITE ET DROGUE
SERVICE DES RENSEIGNEMENTS
CRIMINELLES DU QUEBEC
SYSTEME DE RAPPORTS DE POLICE
SECURITE ROUTIERE ET
TRANSPORT ROUTIER
SERVICE DE SECURITE

SECTION SECURITE INTEGRATION
DES DONNEES
SECTION DES SERVICES DU
RESEAU

SAINT(E)
STATION DE TRANSMISSIONS
OPERATIONNELLES
SUCCURSALE

SUPPORT

SURETE

SURVEILLANCE

SYSTEME(S)

TECHN
TELECOMM
TEMIS
TERR

TRAF
TRANSM
TRANSP

ULF
URC

URCOMM
URS

USR
USRTR

USTEC

VERIF.

YT
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T

TECHNIQUE
TELECOMMUNICATIONS
TEMISCAMINGUE
TERRITOIRE
TRAFIQUANTS
TRANSMISSION
TRANSPORT

u

UNITE DES LOIS FEDERALES
UNITE RENSEIGNEMENTS
CRIMINELS

UNITE RELATIONS COMMUNATAIRE
UNITE RENSEIGNEMENTS
SECURITE

UNITE SECURITE ROUTIERE
UNITE SECURITE ROUTIERE ET
TRANSPORT ROUTIER

UNITE SOUTIEN TECHNIQUE
ENQUETES CRIMINELS

\

VERIFICATION

YUKON
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